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How to Use This Guide

Purpose of This
Guide

The Quantifiler® Kits User’s Manual provides information about and 
instructions for using the Quantifiler® Human DNA Quantification 
Kit and the Quantifiler® Y Human Male DNA Quantification Kit.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for 
emphasis. For example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you 
select from a drop-down or shortcut menu. For example:
Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All 
Runs.
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User Attention
Words

Two user attention words appear in Applied Biosystems user 
documentation. Each word implies a particular level of observation 
or action as described below:

Note: Provides information that may be of interest or help but is not 
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you 
need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet 
for each 96-well plate.

Safety Alert
Words

Safety alert words also appear in user documentation. For more 
information, see “Safety Alert Words” on page ix. 
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Safety

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user 
documentation at points in the document where you need to be aware 
of relevant hazards. Each alert word–IMPORTANT, CAUTION, 
WARNING, DANGER–implies a particular level of observation or 
action, as defined below:

IMPORTANT! – Indicates information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

 – Indicates a potentially hazardous situation that, 
if not avoided, may result in minor or moderate injury. It may also be 
used to alert against unsafe practices.

 – Indicates a potentially hazardous situation that, 
if not avoided, could result in death or serious injury.

 – Indicates an imminently hazardous situation 
that, if not avoided, will result in death or serious injury. This signal 
word is to be limited to the most extreme situations.

Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals 
used with Applied Biosystems instruments and protocols are 
potentially hazardous and can cause injury, illness, or death.
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Chemical Safety
Guidelines

To minimize the hazards of chemicals:

• Read and understand the Material Safety Data Sheets (MSDS) 
provided by the chemical manufacturer before you store, handle, 
or work with any chemicals or hazardous materials. (See “About 
MSDSs.”)

• Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (for example, 
safety glasses, gloves, or protective clothing). For additional 
safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (for 
example, fume hood). For additional safety guidelines, consult 
the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill 
occurs, follow the manufacturer’s cleanup procedures as 
recommended on the MSDS.

• Comply with all local, state/provincial, or national laws and 
regulations related to chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets 
(MSDSs) with shipments of hazardous chemicals to new customers. 
They also provide MSDSs with the first shipment of a hazardous 
chemical to a customer after an MSDS has been updated. MSDSs 
provide the safety information you need to store, handle, transport, 
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous 
chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs The MSDS for any chemical supplied by Applied Biosystems is 
available to you free 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Type in the chemical name, part number, or other 
information that you expect to appear in the MSDS of 
interest.

b. Select the language of your choice.

c. Click Search.

https://docs.appliedbiosystems.com/msdssearch.html
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3. To view, download, or print the document of interest:

a. Right-click the document title.

b. Select:
• Open – To view the document
• Save Target As – To download a PDF version of the 

document to a destination that you choose
• Print Target – To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search 
Results page:

a. Select Fax or Email below the document title.

b. Click RETRIEVE DOCUMENTS at the end of the 
document list.

c. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied 
Biosystems, contact the chemical manufacturer.

Chemical Waste
Hazard

CHEMICAL WASTE HAZARD. Some wastes 
produced by the operation of the instrument or system are potentially 
hazardous and can cause injury, illness, or death.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) 
provided by the manufacturers of the chemicals in the waste 
container before you store, handle, or dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary 
waste container holds the immediate waste. A secondary 
container contains spills or leaks from the primary container. 
Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container 
storage.) 

• Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (for example, 
safety glasses, gloves, or protective clothing). For additional 
safety guidelines, consult the MSDS.
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• Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (for 
example, fume hood).For additional safety guidelines, consult 
the MSDS.

• Handle chemical wastes in a fume hood.
• After emptying the waste container, seal it with the cap 

provided.
• Dispose of the contents of the waste tray and waste bottle in 

accordance with good laboratory practices and local, 
state/provincial, or national environmental and health 
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the 
instrument, you must:

• Characterize (by analysis if necessary) the waste generated by 
the particular applications, reagents, and substrates used in your 
laboratory.

• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, 

transported, and disposed of according to all local, 
state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require 
special handling, and disposal limitations may apply.

Biological Hazard
Safety

BIOHAZARD. Biological samples such as 
tissues, body fluids, and blood of humans and other animals have the 
potential to transmit infectious diseases. Follow all applicable local, 
state/provincial, and/or national regulations. Wear appropriate 
protective eyewear, clothing, and gloves. Read and follow the 
guidelines in these publications:

• U.S. Department of Health and Human Services guidelines 
published in Biosafety in Microbiological and Biomedical 
Laboratories (stock no. 017-040-00547-4; 
http://bmbl.od.nih.gov)

http://bmbl.od.nih.gov
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• Occupational Safety and Health Standards, Bloodborne 
Pathogens
(29 CFR§1910.1030; http://www.access.gpo.gov/nara/cfr/ 
waisidx_01/29cfr1910a_01.html).

Additional information about biohazard guidelines is available at: 
http://www.cdc.gov

http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.cdc.gov
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How to Obtain More Information

Related
Documentation

• ABI PRISM® 7000 Sequence Detection System User Guide – 
Describes the 7000 SDS hardware and software and provides 
information on preparing, maintaining, and troubleshooting the 
system.

• ABI PRISM® 7900HT Sequence Detection System User Guide – 
Describes the 7900HT SDS hardware and software and provides 
information on preparing, maintaining, and troubleshooting the 
system.

Note: For additional documentation, see “How to Obtain Support” 
below.

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for 
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

How to Obtain Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for 
Support.

At the Support page, you can:

• Obtain worldwide telephone and fax numbers to contact 
Applied Biosystems Technical Support and Sales facilities

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates 

of analysis, and other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

mailto:techpubs@appliedbiosystems.com
http://www.appliedbiosystems.com
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1Overview 1

This chapter covers:

Product Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2
Chemistry Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-3
Instrument Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-7
SDS Software Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-8
Real-Time Data Analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-10
Procedural Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-15
Materials and Equipment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-16
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Product Overview

Purpose The Quantifiler® Human DNA Quantification Kit (PN 4343895) and 
the Quantifiler® Y Human Male DNA Quantification Kit 
(PN 4343906) are designed to quantify the total amount of 
amplifiable human (and higher primate) DNA or human male DNA 
in a sample. The results from using the kits can aid in determining:

• If sufficient human DNA or human male DNA is present to 
proceed with short tandem repeat (STR) analysis

• How much sample to use in STR analysis applications

Product
Description

The Quantifiler kits contain all the necessary reagents for the 
amplification, detection, and quantification of a human-specific 
DNA target or a human male-specific DNA target.

The reagents are designed and optimized for use with the following 
Applied Biosystems instruments and software:

• ABI PRISM® 7000 Sequence Detection System and SDS 
Software v1.0

• ABI PRISM® 7900HT Sequence Detection System (no 
automation module) and SDS Software v2.0.

See Chapter 6, “Experiments and Results,” for validation studies 
performed using the Applied Biosystems 7500 Real-Time PCR 
System with SDS Software v1.2.3 and the ABI PRISM® 7000 
Sequence Detection System with SDS Software v1.2.3.
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Chemistry Overview

Assay Overview The DNA quantification assay combines two 5′ nuclease assays:

• A target-specific (human DNA or human male DNA) assay
• An internal PCR control (IPC) assay

Target-Specific
Assay

Components

The target-specific assay consists of:

• Two primers for amplifying human DNA or human male DNA
• One TaqMan® MGB probe labeled with FAM™ dye for 

detecting the amplified sequence

About the Targets Table 1-1 provides information about the targets of PCR 
amplification in the Quantifiler Human kit and the Quantifiler Y kit.

IPC Assay
Components

The IPC assay consists of:

• IPC template DNA (a synthetic sequence not found in nature)
• Two primers for amplifying the IPC template DNA
• One TaqMan® MGB probe labeled with VIC® dye for detecting 

the amplified IPC DNA

Table 1-1 Targets of Quantifiler kits

Kit Gene Target Location Amplicon 
Length

Region 
Amplified Ploidy

Quantifiler Human kit Human telomerase 
reverse 
transcriptase gene 
(hTERT)

5p15.33 62 bases Nontranslated 
region (intron)

Diploida

Quantifiler Y kit Sex-determining 
region Y gene (SRY)

Yp11.3 64 bases Nontranslated 
region

Haploida

a. Single-copy target.
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About the Probes The TaqMan MGB probes contain:

• A reporter dye (FAM™ dye or VIC® dye) linked to the 5′ end of 
the probe

• A minor groove binder (MGB) at the 3´ end of the probe
This modification increases the melting temperature (Tm) 
without increasing probe length (Afonina et al., 1997; Kutyavin 
et al., 1997), which allows the design of shorter probes.

• A nonfluorescent quencher (NFQ) at the 3′ end of the probe
Because the quencher does not fluoresce, Applied Biosystems 
sequence detection systems can measure reporter dye 
contributions more accurately.

5′ Nuclease
Assay Process

The 5′ nuclease assay process (Figures 1-1 through 1-5) takes place 
during PCR amplification. This process occurs in every cycle and 
does not interfere with the exponential accumulation of product.

Figure 1-1 Legend for 5′ nuclease assay process figures

During PCR, the TaqMan MGB probe anneals specifically to a 
complementary sequence between the forward and reverse primer 
sites (Figure 1-2).

When the probe is intact (Figures 1-2 and 1-3), the proximity of the 
reporter dye to the quencher dye results in suppression of the reporter 
fluorescence primarily by Förster-type energy transfer (Förster, 1948; 
Lakowicz, 1983).
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Figure 1-2 Polymerization

Figure 1-3 Strand displacement

AmpliTaq Gold® DNA polymerase cleaves only probes that are 
hybridized to the target (Figure 1-4). Cleavage separates the reporter 
dye from the quencher dye, which results in increased fluorescence 
by the reporter. The increase in fluorescence signal occurs only if the 
target sequence is complementary to the probe and is amplified 
during PCR. Because of these requirements, nonspecific 
amplification is not detected.

Figure 1-4 Cleavage
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Polymerization of the strand continues, but because the 3′ end of the 
probe is blocked, there is no extension of the probe during PCR 
(Figure 1-5).

Figure 1-5 Completion of polymerization
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Instrument Overview

Fluorescence
Detection

Detection on the ABI PRISM 7000 Sequence Detection System

1. A tungsten-halogen lamp directs light to each well on the 
reaction plate. The light passes through the ABI PRISM™ 
Optical Adhesive Cover and excites the fluorescent dyes in each 
well of the plate.

2. A system of lenses, filters, and a dichroic mirror focuses the 
fluorescence emission into a charge-coupled device (CCD) 
camera.

3. Based on wavelength, the filters separate the light into a 
predictably spaced pattern across the CCD camera.

4. During the run, the CCD camera detects the fluorescence 
emission between 500 nm and 660 nm from each well.

5. The SDS software obtains the fluorescence emission data from 
the CCD camera and applies data analysis algorithms.

Detection on the ABI PRISM 7900HT Sequence Detection System

1. An argon ion laser directs light to each well on the microplate. 
The light passes through the ABI PRISM Optical Adhesive Cover 
and excites the fluorescent dyes in each well of the plate.

2. A system of lenses, filters, and a dichroic mirror focuses the 
fluorescence emission into a grating.

3. Based on wavelength, the grating separates the light into a 
predictably spaced pattern across the CCD camera.

4. During the run, the CCD camera detects the fluorescence 
emission between 500 nm and 660 nm from each well.

5. The SDS software obtains the fluorescence emission data from 
the CCD camera and applies data analysis algorithms.
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SDS Software Overview
This section describes how the SDS software analyzes raw run data 
from real-time runs. Raw data consists of the spectral data between 
500 nm to 660 nm collected by the SDS software during a sequence 
detection run.

Composite
Spectrum

Figure 1-6 shows a composite fluorescence spectrum from a single 
well containing the passive reference, one probe labeled with FAM™ 
dye and a nonfluorescent quencher, and one probe labeled with VIC® 
dye and a nonfluorescent quencher. The example shows how the 
overlapping component dye spectra contribute to the composite 
spectrum.

Figure 1-6 Example of a composite spectrum
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Processing
Multicomponent

Data

During the multicomponent transformation, the SDS software uses 
algorithms to determine the contribution of each dye:

• An algorithm removes the background component stored in the 
background calibration file to eliminate the contribution of 
background fluorescence in the raw data.

• The software uses the extracted pure dye standards to express 
the composite spectrum in terms of the pure dye components.

• Then, an algorithm applies matrix calculations to determine the 
contributions of each component dye to the composite spectrum.

The software uses the pure dye spectra, generated as part of 
instrument calibration, to solve for coefficients a, b, and c and to 
calculate the mean standard error (MSE) in the following equation:

where coefficients a, b, and c represent the contribution of each dye 
to the composite spectrum. The MSE value indicates how closely the 
collective multicomponent spectrum conforms to the raw spectra.

Note: The example equation above assumes that pure dye 
components exist for FAM dye, VIC dye, and ROX dye and for the 
instrument background.

Figure 1-7 Typical component contributions in a multiplex 
reaction

Measured spectrum a FAM( ) b VIC( ) c ROX( ) d Background( ) MSE+ + + +=

Background 
component

MSE 

VIC dye component

ROX dye component

FAM dye component

Time

Te
m

p
er

at
ur

e

0

4000

83

73

63

53

8000

12000

6978

93

Fl
uo

re
sc

en
ce

0:10 0:30 0:50 1:10 1:30



Chapter 1 Overview

1-10 Quantifiler Kits User’s Manual

Normalization of
Reporter Signals

The SDS software displays cycle-by-cycle changes in normalized 
reporter signal (Rn). The SDS software normalizes each reporter 
signal by dividing it by the fluorescent signal of the passive reference 
dye. Because the passive reference is one component of the PCR 
master mix, it is present at the same concentration in all wells of the 
reaction plate. By normalizing the reporter signal using the passive 
reference, the software can account for minor variations in signal 
caused by pipetting inaccuracies and make better well-to-well 
comparisons of reporter signal.

Real-Time Data Analysis
The 7000 SDS and the 7900HT SDS can be used to determine the 
relative quantity of a target nucleic acid sequence in a sample by 
analyzing the cycle-to-cycle change in fluorescent signal as a result 
of amplification during a PCR (Figure 1-8).

Amplification Plot
Example

When using TaqMan probes with the 7000 SDS or 7900HT SDS, the 
fluorescent signal (or normalized reporter, Rn) increases as the 
amount of specific amplified product increases. Figure 1-8 shows the 
amplification of PCR product in a plot of Rn vs. cycle number during 
PCR. This amplification plot contains three distinct phases that 
characterize the progression of the PCR.

Figure 1-8 Phases of PCR amplification
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Phases of
Amplification

Initially, Rn appears as a flat line because the fluorescent signal is 
below the detection limit of the sequence detector.

Phase 1: Geometric (Exponential)

Signal is detected and increases in direct proportion to the increase of 
PCR product. As PCR product continues to increase, the ratio of 
AmpliTaq Gold polymerase to PCR product decreases.

During the geometric phase, amplification is characterized by a high 
and constant efficiency. It occurs between the first detectable rise in 
fluorescence and before the beginning of the linear phase. During the 
geometric phase, a plot of DNA concentration versus cycle number 
on a log scale should approximate a straight line with a slope. 
Typically, the SDS system is sufficiently sensitive to detect at least 
3 cycles in the geometric phase, assuming reasonably optimized PCR 
conditions. When the template concentration reaches 10−8 M, PCR 
product stops accumulating exponentially.

Phase 2: Linear

During the linear phase, the slope of the amplification plot decreases 
steadily. At this point, one or more components of the PCR has 
decreased below a critical concentration, and the amplification 
efficiency begins to decrease. This phase is termed linear because 
amplification approximates an arithmetic progression, rather than a 
geometric increase. Because the amplification efficiency is 
continually decreasing during the linear phase, it exhibits low 
precision. 

Phase 3: Plateau

The amplification plot achieves the plateau phase when the PCR 
stops, the Rn signal remains relatively constant, and the template 
concentration reaches a plateau at about 10−7 M (Martens and Naes, 
1989).
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Relationship of
Amplified PCR

Product to Initial
Template

Concentration

Because of the progressive cleavage of TaqMan fluorescent probes 
during the PCR, as the concentration of amplified product increases 
in a sample, so does the Rn value. The following equation describes 
the relationship of amplified PCR product to initial template during 
the geometric phase:

where Nc is the concentration of amplified product at any cycle, N is 
the initial concentration of target template, E is the efficiency of the 
system, and c is the cycle number.

For example, with the dilutions of RNase P target in the TaqMan® 
RNase P Instrument Verification Plate, the ratio of template 
concentration to detectable signal is preserved in the geometric phase 
for all dilutions (Figure 1-9). As the rate of amplification approaches 
a plateau, the amount of product is no longer proportional to the 
initial number of template copies.

Figure 1-9 Amplification plot from a real-time run of an RNase P 
Instrument Verification Plate 
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About the
Threshold

The SDS software uses a threshold setting to define the level of 
detectable fluorescence. Based on the number of cycles required to 
reach the threshold, the SDS software can compare test samples 
quantitatively: A sample with a higher starting template copy number 
reaches the threshold earlier than a sample with a lower starting 
template copy number.

About the
Threshold Cycle

The threshold cycle (CT) for a specified amplification plot occurs 
when the fluorescent signal increases beyond the value of the 
threshold setting. The CT value depends on:

• Starting template copy number
• Efficiency of DNA amplification by the PCR system

How CT Values
Are Determined

To determine the CT value, the SDS software uses the Rn values 
collected from a predefined range of PCR cycles called the baseline 
(the default baseline occurs between cycles 6 and 15 on the 
7000 SDS and between cycles 3 and 15 on the 7900HT SDS):

1. The software generates a baseline-subtracted amplification plot 
of ∆Rn versus cycle number.

2. An algorithm defines the cycle where the ∆Rn value crosses the 
threshold setting (the default threshold setting is 0.2) as the 
threshold cycle (CT).
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Relationship of
Threshold Cycles
to Initial Template

Amount

The following equation describes the exponential amplification of 
the PCR:

where:

Xn = number of target molecules at cycle n (so that n > m)

Xm = number of target molecules at cycle m

EX = efficiency of target amplification (between 0 and 1)

n − m = number of cycles elapsed between cycle m and cycle n

Amplicons designed and optimized according to Applied Biosystems 
guidelines (amplicon size <150 bp) have amplification efficiencies 
that approach 100%. Therefore EX = 1 so that:

To define the significance in amplified product of one thermal cycle, 
set n − m = 1 so that:

Therefore, each cycle in the PCR reaction corresponds to a two-fold 
increase in product. Likewise, a difference in CT values of 1 equates 
to a two-fold difference in initial template amount.

Xn Xm 1 EX+( )n m–=

Xn Xm 1 1+( )n m–=

Xm 2( )n m–=

Xn Xm 2( )1
=

2Xm=
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Procedural Overview
Use of the Quantifiler kits involves the following workflow:

Software Setup

PCR Amplification

Data Analysis

Interpretation of Results
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Materials and Equipment

Kit Contents and
Storage

Each Quantifiler® kit contains materials sufficient to perform 400 
reactions at a 25-µL reaction volume.

Additional
Storage

Guidelines For
Primer Mixes

Follow the additional guidelines for storing the primer mixes:

• Minimize freeze-thaw cycles.
• Keep protected from direct exposure to light. Excessive 

exposure to light may affect the fluorescent probes.

Table 1-2 Quantifiler kit contents

Reagent Contents Quantity Storage

Quantifiler® Human Primer Mix or

Quantifiler® Y Human Male Primer Mix

• Forward and reverse 
primers to amplify 
human DNA or human 
male DNA target

• Probe to detect 
human DNA or human 
male DNA target

• IPC system primers, 
template, and probe

3 tubes, 
1.4 mL 
each

−15 to −25 °C

Quantifiler Human DNA Standard 200 ng/µL purified DNA 
standard

1 tube, 
120 µL

−15 to −25 °C

Quantifiler PCR Reaction Mix AmpliTaq Gold® DNA 
Polymerase, dNTPs with 
dUTP, Passive Reference, 
and optimized buffer 
components

1 tube, 
5 mL

2 to 8 °C
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Equipment and
Materials Not

Included

Tables 1-3 through 1-5 list required and optional equipment and 
materials not supplied with the Quantifiler kits. Unless otherwise 
noted, many of the items are available from major laboratory 
suppliers (MLS).

Table 1-3 Equipment

Equipment Source

Applied Biosystems 7900HT Real-Time PCR 
System (no automation)

Contact your local 
Applied Biosystems 
sales representative.

ABI PRISM® 7000 Sequence Detection System

Tabletop centrifuge with 96-well plate 
adapters (optional)

MLS

Table 1-4 User-supplied materials

Material Source

Quantifiler® Human DNA Quantification Kit Applied Biosystems 
(PN 4343895)

Quantifiler® Y Human Male DNA 
Quantification Kit

Applied Biosystems 
(PN 4343906)

Glycogen, 20 mg (1 mL) Roche Applied Science 
(PN 901 393)

High-Throughput Setup

96-Well Optical Reaction Plates Applied Biosystems 
(PN 4306737)

Optical Adhesive Covers Starter Kit (20 
covers, 1 compression pad, 1 applicator)

Applied Biosystems 
(PN 4313663)

Optical Adhesive Covers (100 covers) Applied Biosystems 
(PN 4311971)

MicroAmp™ Splash Free Support Base Applied Biosystems 
(PN 4312063)
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Mid-to-Low-Throughput Setup

MicroAmp® Optical Tubes (8 tubes/strip, 125 
strips)

Applied Biosystems 
(PN 4316567)

MicroAmp™ 96-Well Tray/Retainer Set Applied Biosystems 
(PN 403081)

Optical Caps (8 caps/strip, 300 strips) Applied Biosystems 
(PN 4323032)

Compression pad from Optical Adhesive 
Covers Starter Kit

Note: Not necessary if using Optical Caps

Applied Biosystems 
(PN 4313663)

Table 1-5 Documents

Document Applied Biosystems 
Part Number

ABI PRISM® 7000 Sequence Detection System 
User Guide

4330228

ABI PRISM® 7900HT Sequence Detection 
System User Guide

4317596

Table 1-4 User-supplied materials (continued)

Material Source
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2Software Setup 2

This chapter covers:

Section 2.1 7000 SDS Software Setup  . . . . . . . . . . . . . . . . . . . . .2-3
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4
Starting the 7000 SDS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5
About Plate Documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-7
Setting Up a Plate Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-10
Setting Up a Plate Document Template  . . . . . . . . . . . . . . . . . . . .2-22
Section 2.2 7900HT SDS Software Setup  . . . . . . . . . . . . . . . . .2-25
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-26
Starting the 7900HT Real-Time PCR System. . . . . . . . . . . . . . . .2-27
About Plate Documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-28
Setting Up a Plate Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-31
Setting Up a Plate Document Template  . . . . . . . . . . . . . . . . . . . .2-40
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Section 2.1 7000 SDS Software Setup

This section covers:

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4
Starting the 7000 SDS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5
About Plate Documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-7
Setting Up a Plate Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-10
Setting Up a Plate Document Template  . . . . . . . . . . . . . . . . . . . .2-22
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Overview

Purpose During software setup, you start up the ABI PRISM® 7000 Sequence 
Detection System (7000 SDS) and set up a plate document for DNA 
quantification using the Quantifiler® kits.

Configuration The Quantifiler® kits are supported using the 7000 SDS and 
Sequence Detection Systems (SDS) Software v1.0 for real-time data 
collection and analysis.
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Starting the 7000 SDS

Overview Starting the 7000 SDS involves:

1. Starting the Computer

2. Powering On the Instrument (page 2-6)

3. Starting SDS Software (page 2-6)

Starting the
Computer 1. If you are using the laptop computer, open it by pushing in 

the front, center button, holding it, and lifting up the lid.

2. Press the power button on the computer.

3. In the Enter User name field of the login window, type your 
name or the user name associated with the computer.

4. If required, type your password in the Password field.

G
R

20
78Instrument power button

Laptop power button
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Powering On the
Instrument

Note: Wait for the computer to finish starting up before powering on 
the 7000 instrument.

PHYSICAL INJURY HAZARD. Moving parts 
can crush and cut. Keep hands clear of moving parts while operating. 
Disconnect power before servicing the instrument.

Press the power button on the lower left front of the instrument.

Starting SDS
Software

Select Start > ABI Prism 7000 > ABI Prism 7000 SDS Software.

The software attempts to initialize the instrument and displays a 
message in the status bar for a few seconds. Then the computer 
attempts to establish communication with the 7000 instrument. If the 
connection is successful, the software displays  in the 
status bar.

Power button
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About Plate Documents

How Plate
Documents Are

Used

Running a reaction plate on the 7000 SDS requires creating and 
setting up a plate document using the SDS software. A plate 
document is a representation of the arrangement of samples 
(standards and unknowns) and detectors on the reaction plate. The 
SDS software uses the plate document to:

• Coordinate the instrument operation, such as thermal cycling 
and data collection

• Organize and store the data gathered during the run
• Analyze the data from the run

Plate Document
Types

You can use the SDS software to create two types of plate document 
files.

Plate Document Type File Extension Description

SDS document *.sds Primary file to use when performing a run. Required for 
all experiments.

SDS template *.sdt File that already contains run parameters that are 
commonly used in plate documents, such as detectors, 
thermal cycler conditions, and so on. Streamlines the 
creation of the SDS document (*.sds) file.
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Example Plate
Document Setup

You can arrange the reactions in any well of the reaction plate, but 
you need to set up the plate document so that it corresponds exactly 
to the arrangement of the standards and unknown samples in the 
wells of the reaction plate.

Figure 2-1 shows one example of arranging reactions when running 
two Quantifiler kits on one 96-well reaction plate:

• Wells A1 through D12 (gray) correspond to reactions using the 
Quantifiler Human kit

• Wells E1 through H12 (white) correspond to reactions using the 
Quantifiler Y kit

Note: For each Quantifiler kit assay, there are eight DNA 
quantification standards and two reactions for each standard. See 
“Preparing the DNA Quantification Standard” on page 3-2 for more 
information about the DNA quantification standards.

Figure 2-1 Example plate setup of reactions with two kits

1 2 3 4 5 6 7 8 9 10 11 12

A Std 1 Std 1 Std 2 Std 2 Std 3 Std 3 Std 4 Std 4 Std 5 Std 5 Std 6 Std 6

B Std 7 Std 7 Std 8 Std 8 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

C UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

D UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

E Std 1 Std 1 Std 2 Std 2 Std 3 Std 3 Std 4 Std 4 Std 5 Std 5 Std 6 Std 6

F Std 7 Std 7 Std 8 Std 8 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

G UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

H UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN
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Figure 2-2 shows another example of arranging reactions when 
running two Quantifiler kits on one 96-well reaction plate if you are 
using repeat pipettors:

• Wells A1 through D6 (gray) correspond to reactions using the 
Quantifiler Human kit

• Wells A7 through H12 (white) correspond to reactions using the 
Quantifiler Y kit

Note: For each Quantifiler kit assay, there are eight DNA 
quantification standards and two reactions for each standard. See 
“Preparing the DNA Quantification Standard” on page 3-2 for more 
information about the DNA quantification standards.

Figure 2-2 Example plate setup of reactions using repeat 
pipettors

1 2 3 4 5 6 7 8 9 10 11 12

A Std 1 Std 1 UNKN UNKN UNKN UNKN Std 1 Std 1 UNKN UNKN UNKN UNKN

B Std 2 Std 2 UNKN UNKN UNKN UNKN Std 2 Std 2 UNKN UNKN UNKN UNKN

C Std 3 Std 3 UNKN UNKN UNKN UNKN Std 3 Std 3 UNKN UNKN UNKN UNKN

D Std 4 Std 4 UNKN UNKN UNKN UNKN Std 4 Std 4 UNKN UNKN UNKN UNKN

E Std 5 Std 5 UNKN UNKN UNKN UNKN Std 5 Std 5 UNKN UNKN UNKN UNKN

F Std 6 Std 6 UNKN UNKN UNKN UNKN Std 6 Std 6 UNKN UNKN UNKN UNKN

G Std 7 Std 7 UNKN UNKN UNKN UNKN Std 7 Std 7 UNKN UNKN UNKN UNKN

H Std 8 Std 8 UNKN UNKN UNKN UNKN Std 8 Std 8 UNKN UNKN UNKN UNKN
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Setting Up a Plate Document

Overview Setting up a plate document to run Quantifiler kit assays involves:

1. Creating a Blank Plate Document (page 2-10)

2. Creating Detectors (the first time only, page 2-11)

3. Adding Detectors to the Plate Document (page 2-14)

4. Applying Detectors for Standards (page 2-15)

5. Applying Detectors for Unknown Samples (page 2-17)

6. Adding Sample Names for Unknown Samples (page 2-18)

7. Setting Thermal Cycler Conditions (page 2-19)

8. Saving the Plate Document (page 2-21)

Creating a Blank
Plate Document

To create a blank plate document:

1. If the SDS software is not already started, select Start > 
Programs > ABI Prism 7000 > ABI Prism 7000 SDS 
Software.

2. In the SDS software, select File > New to open the New 
Document dialog box.

Default 
settings
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Creating
Detectors

Before you set up the plate document, you need to create detectors in 
the SDS software for running Quantifiler kit assays. After the 
detectors are created, you do not need to create detectors for 
subsequent runs of Quantifiler kit assays and you can skip to “Adding 
Detectors to the Plate Document” on page 2-14.

3. Click OK to use the default settings and to view a blank 
plate document:

To create a blank plate document: (continued)

To create detectors:

1. Select Tools > Detector Manager.

2. In the lower left part of the Detector Manager dialog box, 
select File > New to open the New Detector dialog box.
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3. Create a detector for the Quantifiler Human kit:

4. Click Create Another to add the Quantifiler Human 
detector and to reset the New Detector dialog box.

5. Create a detector for the Quantifiler Y kit:

6. Click Create Another to add the Quantifiler Y detector and 
to reset the New Detector dialog box.

To create detectors: (continued)

Enter Quantifiler Human

Select FAM

Make sure (none) is 
selected

Click to select a color

Enter Quantifiler Y

Select FAM

Make sure (none) is 
selected

Click to select a color
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7. Create a detector for the IPC assay:

8. Click OK to add the IPC detector and to return to the 
Detector Manager dialog box.

To create detectors: (continued)

Enter IPC

Select VIC

Make sure (none) is 
selected

Click to select a color
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Adding Detectors
to the Plate
Document

To add detectors to the plate document:

1. In the SDS software, select Tools > Detector Manager. If 
the detectors for the Quantifiler kits have been created, they 
are listed in the Detector Manager:

2. In the Detector Manager, select the Quantifiler Human, 
Quantifiler Y, and the IPC detectors by clicking them while 
pressing the Ctrl key.

3. Click Add To Plate Document.

4. Click Done to close the Detector Manager.
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Applying
Detectors for

Standards

You need to apply detectors to the plate document for the wells on the 
reaction plate that contain DNA quantification standards. Repeat the 
procedure until you complete applying detector tasks, quantities, and 
sample names for all quantification standards.

IMPORTANT! Set up detectors for each quantity and for each kit 
separately. For example, set up detectors for quantification standard 1 
for the Quantifiler Human kit first, and then for quantification 
standard 2 for the Quantifiler Human kit, and so on, until you finish 
setting up the detectors for all wells containing quantification 
standards

To apply detectors for quantification standards:

1. Select View > Well Inspector to open the dialog box:

Note: The Well Inspector displays the detectors that were 
added to the plate document.

2. On the Plate tab, select wells that correspond to a specific 
quantification standard for one kit.

Make sure that 
ROX is selected

Wells selected
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3. With the wells selected, go to the Well Inspector and:

a. Select the Use boxes for the applicable detectors:
• IPC
• Quantifiler Human or Quantifiler Y

b. For the Quantifiler Human or Quantifiler Y detector, 
click Unknown in the Task column, then select 
Standard from the drop-down list.

c. For the Quantifiler Human or Quantifiler Y detector, 
select the Quantity field for the appropriate detector and 
enter the quantity of DNA in the well.

IMPORTANT! Although you do not enter units for 
Quantity, you must use a consistent unit (for example, 
ng/µL) for all standard quantities. The units used for 
standard quantities defines the quantification units for 
analysis results.

Note: Leave the IPC detector Task for standard 
reactions set to Unknown. Quantity values are not 
needed for IPC detectors.

d. Enter the Sample Name (for example, Std. 1, Std. 2, and 
so on).

For example:

To apply detectors for quantification standards: (continued)

Task for IPC set 
to Unknown 
(default)
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Applying
Detectors for

Unknown
Samples

You need to apply detectors to the plate document for the wells on the 
reaction plate that contain unknown samples.

IMPORTANT! If you run reactions for the Quantifiler Human kit and 
the Quantifiler Y kit on the same plate, apply detectors for unknown 
samples for each kit separately.

To apply detectors for unknown samples:

1. On the Plate tab, select the wells that correspond to all 
unknown samples for one Quantifiler kit.

2. With the well(s) selected, select View > Well Inspector and 
check the Use boxes for the applicable detectors:

• Quantifiler Human or Quantifiler Y
• IPC

For example:

3. If you are running both kits on the reaction plate, repeat 
steps 1 and 2 for the unknown samples for the other kit.

4. Select View > Well Inspector to close the Well Inspector.

Make sure 
that ROX is 
selected
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Adding Sample
Names for
Unknown
Samples

Repeat the procedure to add sample names for all unknown samples.

To add sample names for unknown samples:

1. On the Plate tab, select one well containing an unknown 
sample.

2. With the well selected, select View > Well Inspector and 
enter the Sample Name.

For example:

Note: Samples with identical sample names are treated as 
replicates by the SDS software. Results for replicate 
reactions are grouped together automatically for data 
analysis.
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Setting Thermal
Cycler Conditions

Before running a Quantifiler kit assay, you need to make two changes 
to the default thermal cycler conditions:

• Thermal profile
• Sample volume

To set thermal cycler conditions:

1. In the plate document, select the Instrument tab.

2. Press the Shift key and click within the Stage 1 hold step 
(50 °C for 2 minutes) to select it.

3. After the hold step is selected, press the Delete key.

Press the Shift 
key while you 
click within the 
Stage 1 hold step

Stage 1 hold step 
is selected
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4. Make sure that the thermal profile appears as follows:

5. Change the Sample Volume to 25 (µL) and make sure that 
the 9600 Emulation box is selected.

Note: Selecting the 9600 Emulation box reduces the ramp 
rate.

To set thermal cycler conditions: (continued)

Set the volume to 
25 µL

Make sure that this box is selected
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Saving the Plate
Document

Before running the reaction plate, save the plate document as an SDS 
Document (*.sds) file.

Note: To save the plate document as a template, see “Setting Up a 
Plate Document Template” on page 2-22.

To save the plate document:

1. Select File > Save.

2. Select the location for the plate document.

3. Enter a file name.

4. For Save as type, select SDS Documents (*.sds).

5. Click Save.
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Setting Up a Plate Document Template

Purpose A plate document template reduces the time required to set up a plate 
document. This section describes how to create an SDS Template 
Document (*.sdt) for running Quantifiler kit assays.

Template Settings In addition to plate document settings (assay and container), 
templates can contain:

• Assay-specific detectors
• Well assignments for quantification standards, with detectors, 

tasks, and quantity
• Well assignments for unknown samples, with detectors and tasks
• Instrument settings: thermal cycler conditions and reaction 

volume settings

Creating a Plate
Document

Template

This procedure assumes that you have created the detectors for 
running reactions using the Quantifiler kits (page 2-11).

To create a plate document template:

1. If the SDS software is not already started, select Start > 
Programs > ABI Prism 7000 > ABI Prism 7000 SDS 
Software.

2. Select File > New, complete the New Document dialog box, 
then click OK.

3. Apply the desired template settings to the plate document:
• Add detectors to the plate document (page 2-14)
• Apply detectors for standards and for unknown samples 

(page 2-15 and page 2-17)
• Set thermal cycler conditions (page 2-19)
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4. Select File > Save As and complete the Save As dialog box:

a. For Save as type, select SDS Templates (*.sdt).

b. Locate and select the Templates folder within the 
software folder:
X:Program Files > ABI Prism 7000 > Templates, 
where X is the hard drive on which the SDS software is 
installed.

Note: Saving the template file in the Templates folder 
makes the template available in the Template drop-
down list of the New Document dialog box (see step 2 
in “Creating a Plate Document from a Template” on 
page 2-24).

c. For File name, enter a name for the template. For 
example, enter Quantifiler Template:

d. Click Save.

To create a plate document template: (continued)

Save the template file in the Templates folder

Enter a name for the template
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Creating a Plate
Document from a

Template

After you create a template, you can use it to create a plate document.

To create a plate document from a template:

1. If the SDS software is not already started, select Start > 
Programs > ABI Prism 7000 > ABI Prism 7000 SDS 
Software.

2. Select File > New and in the New Document dialog box and 
make the following selections:

• For Assay, select Absolute Quantitation.
• For Container, select 96-Well Clear.
• For Template, select an appropriate template from the 

list.

Note: If the template is not available in the list, click Browse 
to locate and select an appropriate template.

3. Complete the plate document setup:
• Add detectors to the plate document (page 2-14)
• Apply detectors for standards and for unknown samples 

(page 2-15 and page 2-17)
• Set thermal cycler conditions (page 2-19)

Note: The tasks that you perform vary according to which 
settings were defined in the template.

4. Save the plate document (page 2-21).

Note: For Save as type, select SDS Documents (*.sds).
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Section 2.2 7900HT SDS Software Setup

This section covers:

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-26
Starting the 7900HT Real-Time PCR System. . . . . . . . . . . . . . . .2-27
About Plate Documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-28
Setting Up a Plate Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-31
Setting Up a Plate Document Template  . . . . . . . . . . . . . . . . . . . .2-40
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Overview

Purpose During software setup, you start up the Applied Biosystems 7900HT 
Real-Time PCR System and set up a plate document for DNA 
quantification using the Quantifiler® kits.

Configuration The Quantifiler® kits are supported using the following configuration 
of the 7900HT Real-Time PCR System for real-time data collection 
and analysis:

• 96-well reaction plates
• Manual setup
• Sequence Detection Systems (SDS) software v2.0

Note: Use of the robotic microplate handler and/or 384-well reaction 
plates is not supported.
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Starting the 7900HT Real-Time PCR System

Overview Starting the Applied Biosystems 7900HT Real-Time PCR System 
involves:

1. Powering on the computer.

2. Powering on the instrument.

3. Starting the SDS software.

Starting the
7900HT System

To start the 7900HT System:

1. Press the power buttons on the computer and on the monitor.

2. In the login screen, enter the User Name and Password.

3. Press the power button below the status lights on the front of 
the instrument.

At startup, the instrument:
• Emits a high-pitched tone, indicating that the system is 

initialized
• Cycles the status lights (red > orange > green), 

indicating that the instrument is active

4. Select Start > Programs > Applied Biosystems > SDS 2.0.

At startup, the software attempts to establish communication 
with the 7900HT instrument. If the connection is successful, 
the software displays  in the status bar.

GR2010

Power button

Green
Orange 
Red 

Status lights
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About Plate Documents

How Plate
Documents Are

Used

Running a reaction plate on the 7900HT Real-Time PCR System 
requires creating and setting up a plate document using the SDS 
software. A plate document is a representation of the arrangement of 
samples (standards and unknowns) and reagents on the reaction plate. 
The SDS software uses the plate document to:

• Coordinate the instrument operation, such as thermal cycling 
and data collection

• Organize and store the data gathered during the run
• Analyze the data from the run

Plate Document
Types

You can use SDS software to create two types of plate document 
files.

Plate Document Type File Extension Description

Single plate document *.sds Primary file to use when performing a run. Required for 
all experiments.

Template plate 
document

*.sdt File that already contains run parameters that are 
commonly used in plate documents, such as detectors, 
thermal cycler conditions, and so on. Streamlines the 
creation of the SDS document (*.sds) file.
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Example Plate
Document Setup

You can arrange the reactions in any well of the reaction plate, but 
you need to set up the plate document so that it corresponds exactly 
to the arrangement of the standards and unknown samples in the 
wells of the reaction plate.

Figure 2-3 shows one example of arranging reactions when running 
two Quantifiler kit assays on one 96-well plate:

• Wells A1 through D12 (gray) correspond to reactions using the 
Quantifiler Human kit

• Wells E1 through H12 (white) correspond to reactions using the 
Quantifiler Y kit

Note: For each Quantifiler kit assay, there are eight DNA 
quantification standards and two reactions for each standard. See 
“Preparing the DNA Quantification Standard” on page 3-2 for more 
information about the DNA quantification standards.

Figure 2-3 Example arrangement of reactions with two kits

1 2 3 4 5 6 7 8 9 10 11 12

A Std 1 Std 1 Std 2 Std 2 Std 3 Std 3 Std 4 Std 4 Std 5 Std 5 Std 6 Std 6

B Std 7 Std 7 Std 8 Std 8 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

C UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

D UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

E Std 1 Std 1 Std 2 Std 2 Std 3 Std 3 Std 4 Std 4 Std 5 Std 5 Std 6 Std 6

F Std 7 Std 7 Std 8 Std 8 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

G UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

H UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN
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Figure 2-4 shows another example of arranging reactions when 
running two Quantifiler kits on one 96-well reaction plate if you are 
using repeat pipettors:

• Wells A1 through D6 (gray) correspond to reactions using the 
Quantifiler Human kit

• Wells A7 through H12 (white) correspond to reactions using the 
Quantifiler Y kit

Note: For each Quantifiler kit assay, there are eight DNA 
quantification standards and two reactions for each standard. See 
“Preparing the DNA Quantification Standard” on page 3-2 for more 
information about the DNA quantification standards.

Figure 2-4 Example arrangement of reactions using repeat 
pipettors

1 2 3 4 5 6 7 8 9 10 11 12

A Std 1 Std 1 UNKN UNKN UNKN UNKN Std 1 Std 1 UNKN UNKN UNKN UNKN

B Std 2 Std 2 UNKN UNKN UNKN UNKN Std 2 Std 2 UNKN UNKN UNKN UNKN

C Std 3 Std 3 UNKN UNKN UNKN UNKN Std 3 Std 3 UNKN UNKN UNKN UNKN

D Std 4 Std 4 UNKN UNKN UNKN UNKN Std 4 Std 4 UNKN UNKN UNKN UNKN

E Std 5 Std 5 UNKN UNKN UNKN UNKN Std 5 Std 5 UNKN UNKN UNKN UNKN

F Std 6 Std 6 UNKN UNKN UNKN UNKN Std 6 Std 6 UNKN UNKN UNKN UNKN

G Std 7 Std 7 UNKN UNKN UNKN UNKN Std 7 Std 7 UNKN UNKN UNKN UNKN

H Std 8 Std 8 UNKN UNKN UNKN UNKN Std 8 Std 8 UNKN UNKN UNKN UNKN
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Setting Up a Plate Document

Overview Setting up a plate document involves:

1. Creating a Blank Plate Document (page 2-31)

2. Creating Detectors (page 2-32)

3. Copying Detectors to the Plate Document (page 2-34)

4. Applying Detectors for Standards (page 2-35)

5. Applying Detectors for Unknown Samples (page 2-36)

6. Adding Sample Names for Unknown Samples (page 2-37)

7. Setting Thermal Cycler Conditions (page 2-38)

8. Saving the Plate Document (page 2-39)

Creating a Blank
Plate Document

To create a blank plate document:

1. If the SDS software is not already started, select Start > 
Programs > Applied Biosystems > SDS 2.0.

2. Select File > New, complete the New Document dialog box, 
then click OK.
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Creating
Detectors

Before you set up the plate document, you need to create detectors in 
the SDS software for running Quantifiler kit assays. After the 
detectors are created, you do not need to create detectors for 
subsequent runs of Quantifiler kit assays and you can skip to 
“Copying Detectors to the Plate Document” on page 2-34.

To create detectors:

1. With a new plate document open, select Tools > Detector 
Manager.

2. Create a detector for the Quantifiler Human kit:

a. In the lower left part of the Detector Manager, click 
New, then complete the dialog box:

b. Click OK to return to the Detector Manager.
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3. Create a detector for the Quantifiler Y Human Male kit:

a. In the Detector Manager, click New and complete the 
dialog box:

b. Click OK to return to the Detector Manager.

To create detectors: (continued)
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Copying
Detectors to the
Plate Document

4. Create a detector for the IPC assay:

a. In the Detector Manager, click New, then complete the 
Add Detector dialog box:

b. Click OK to return to the Detector Manager.

To create detectors: (continued)

To copy detectors to the plate document:

1. If the Detector Manager is not already open, select Tools > 
Detector Manager.

2. Select the Quantifiler Human, Quantifiler Y, and the IPC 
detectors by clicking them while pressing the Ctrl key.

Note: If the detectors are not available, create them first (see 
page 2-32 for the procedure).

3. With the three detectors selected, click Copy To Plate 
Document.

4. Click Done to close the Detector Manager and return to the 
plate window.
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Applying
Detectors for

Standards

You need to apply the detectors to the plate document for the wells on 
the reaction plate that contain DNA quantification standards. Repeat 
the procedure until you complete applying detector tasks, quantities, 
and sample names for all quantification standards.

IMPORTANT! Set up detectors for each quantity and for each kit 
separately. For example, set up detectors for Std. 1 for the Quantifiler 
Human kit first, and then for Std. 2 for the Quantifiler Human kit, 
and so on, until you finish setting up the detectors for all wells 
containing quantification standards. 

To apply detectors for quantification standards:

1. In the plate grid, press the Ctrl key while you select the wells 
that correspond to a specific quantification standard for one 
kit.

2. Complete the Well Inspector:

a. Select the Use boxes for the applicable detectors:
• IPC
• Quantifiler Human or Quantifiler Y

b. For the Quantifiler Human or Quantifiler Y detector:
• Click Unknown in the Task column, then select 

Standard from the drop-down list.
• Select the Quantity field and enter the quantity of 

DNA in the well.

IMPORTANT! Although you do not enter units for 
Quantity, you must use a consistent unit (for example, 
ng/µL) for all standard quantities. The units used for 
standard quantities defines the quantification units for 
analysis results.

Note: Leave the IPC detector Task for standard 
reactions set to Unknown. Quantity values are not 
needed for IPC detectors.
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Applying
Detectors for

Unknown
Samples

You need to apply detectors to the plate document for the wells on the 
reaction plate that contain unknown samples.

IMPORTANT! If you run reactions for the Quantifiler Human kit and 
the Quantifiler Y kit on the same plate, apply detectors for unknown 
samples for each kit separately.

Step 2 continued:

 c. Enter the Sample Name (for example, Std. 1, Std. 2, and 
so on).

d. Make sure that ROX is selected for the Passive 
Reference.

For example:

To apply detectors for quantification standards: (continued)

Task for IPC set to Unknown 
(default)

To apply detectors for unknown samples:

1. In the plate grid, press the Ctrl key and select the wells that 
contain unknown samples for one kit.

2. In the Well Inspector, select the Use boxes for the detectors 
in the selected wells:

• IPC
• Quantifiler Human or Quantifiler Y

For example:
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Adding Sample
Names for
Unknown
Samples

Repeat this procedure to enter the names for all unknown samples.

3. In the Well Inspector, make sure that ROX is selected for the 
Passive Reference.

To apply detectors for unknown samples: (continued)

To add sample names for unknown samples:

1. In the plate grid, select a reaction well containing an 
unknown sample.

2. In the Well Inspector panel, enter a name in the Sample 
Name field.

Note: Samples with identical sample names are treated as 
replicates by the SDS software. Results for replicate 
reactions are grouped together automatically for data 
analysis.
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Setting Thermal
Cycler Conditions

Before running a Quantifiler kit assay, you need to make two changes 
to the default thermal cycler conditions:

• Thermal profile
• Sample volume

To set thermal cycler conditions:

1. In the plate window, select the Instrument tab.

2. Delete the Stage 1 hold step (50 °C for 2 minutes):

a. Press the Shift key and click within the Stage 1 hold 
step.

b. After the hold step is selected, press the Delete key.

3. Make sure that the thermal profile appears as follows:

Press the Shift key and 
click within the Stage 1 
hold step

Hold step is selected
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Saving the Plate
Document

Before running the reaction plate, save the plate document as an ABI 
PRISM SDS Single Plate (*.sds) file.

Note: To save the document as a template, see “Setting Up a Plate 
Document Template” on page 2-40.

4. Set the Sample Volume to 25 µL and make sure that the 
9600 Emulation box is selected.

Note: Selecting the 9600 Emulation box reduces the ramp 
rate.

5. Make sure that the default settings are kept on the remaining 
tabs:

• Auto Increment
• Ramp Rate
• Data Collection

To set thermal cycler conditions: (continued)

Set the volume to 
25 µL

Make sure that this 
box is selected

To save the plate document:

1. Select File > Save As.

2. For Files of Type, select ABI PRISM SDS Single Plate 
(*.sds).
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Setting Up a Plate Document Template

Purpose A plate document template reduces the time required to set up a plate 
document. This section describes how to create an SDS Template 
Document (*.sdt) set up for running Quantifiler kit assays.

Template Settings In addition to plate document settings (assay and container), 
templates can contain:

• Assay-specific detectors
• Well assignments for quantification standards, with detectors, 

tasks, and quantity
• Well assignments for unknown samples, with detectors and tasks
• Instrument settings: thermal cycler conditions and reaction 

volume settings.

Creating a Plate
Document

Template

This procedure assumes that you have created the detectors for 
running reactions using the Quantifiler kits (page 2-32).

3. Navigate to where you want to save the plate document file.

4. In the File Name field, enter a name for the plate document.

5. Click Save.

To save the plate document: (continued)

To create a plate document template:

1. If the SDS software is not already started, select Start > 
Programs > Applied Biosystems > SDS 2.0.
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2. Select File > New, then complete the New Document dialog 
box:

3. Apply the desired template settings to the plate document:
• Copy detectors (page 2-34)
• Apply detectors for standards (page 2-35)
• Apply detectors for unknown samples (page 2-36)
• Set thermal cycler conditions (page 2-38)

4. Select File > Save As and complete the Save As dialog box:

a. For Files of Type, select ABI PRISM SDS Template 
Document (*.sdt).

b. Locate and select the Templates folder within the 
software folder:
X:Program Files > Applied 
Biosystems>7900HTSDS>Templates, where X is the 
hard drive on which the SDS software is installed.

Note: Saving the template file in the Templates folder 
makes it available in the Template drop-down list of the 
New Document dialog box (see step 2 in “Creating a 
Plate Document from a Template” on page 2-42).

c. Enter a name for the template. For example, enter 
Quantifiler Template.

d. Click Save.

To create a plate document template: (continued)
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Creating a Plate
Document from a

Template

After you create a template, you can use it to create a plate document.

To create a plate document from a template:

1. If the SDS software is not already started, select Start > 
Programs > Applied Biosystems > SDS 2.0.

2. Select File > New and in the New Document dialog box and 
make the following selections:

• For Assay, select Absolute Quantitation.
• For Container, select 96-Well Clear Plate.
• For Template, select an appropriate template from the 

list.

Note: If the template is not available in the list, click Browse 
to locate and select an appropriate template.

3. Complete the plate document setup:
• Copy detectors (page 2-34)
• Apply detectors for standards (page 2-35)
• Apply detectors for unknown samples (page 2-36)
• Set thermal cycler conditions (page 2-38)

Note: The tasks that you perform vary according to which 
settings were defined in the template.

4. Save the plate document (page 2-39).

Note: For Files of Type, select ABI PRISM SDS Single 
Plate (*.sds).
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Preparing the DNA Quantification Standard

Required
Materials

• Pipettors
• Pipette tips
• Quantifiler® Human DNA Standard

Note: The same standard can be used for both Quantifiler® kits.

• T10E0.1 buffer:
– 10 mM Tris-HCl (pH 8.0)
– 0.1 mM Na2EDTA
– 20 µg/mL glycogen (optional)

Note: If you use T10E0.1 buffer with glycogen, you can store the 
DNA quantification standards for up to 2 weeks at 2 to 8 °C.

Guidelines for
Calculating the

Standards
Dilution Series

The standard dilution series example shown in Table 3-1 on page 3-3 
is suitable for general use.

IMPORTANT! Applied Biosystems recommends:

• Three-fold dilution series with eight concentration points in the 
standard series for each assay

• Minimum input volume of 10 µL DNA for dilutions (to ensure 
accuracy of pipetting)
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Standards
Dilution Series

Example

Table 3-1 shows an example of one standards dilution series with the 
concentrations ranging from 50 ng/µL (Std. 1) to 0.023 ng/µL, or 
23 pg/µL (Std. 8). A sample at the lowest concentration (2 µL per 
reaction) contains on average 14 to 16 copies of a diploid single-copy 
locus and 7 to 8 copies of a haploid single-copy locus.

Table 3-1 Standards dilution series example

Standard Concentration 
(ng/µL) Example Amounts Minimum Amounts Dilution 

Factor

Std. 1 50.000 50 µL [200 ng/µL stock] + 
150 µL T10E0.1/glycogen buffer

10 µL [200 ng/µL stock] 
+ 30 µL T10E0.1 buffer

4✕

Std. 2 16.700 50 µL [Std. 1] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 1] +
20 µL T10E0.1 buffer

3✕

Std. 3 5.560 50 µL [Std. 2] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 2] +
20 µL T10E0.1 buffer

3✕

Std. 4 1.850 50 µL [Std. 3] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 3] +
20 µL T10E0.1 buffer

3✕

Std. 5 0.620 50 µL [Std. 4] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 4] +
20 µL T10E0.1 buffer

3✕

Std. 6 0.210 50 µL [Std. 5] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 5] +
20 µL T10E0.1 buffer

3✕

Std. 7 0.068 50 µL [Std. 6] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 6] +
20 µL T10E0.1 buffer

3✕

Std. 8 0.023 50 µL [Std. 7] +
100 µL T10E0.1/glycogen buffer

10 µL [Std. 7] +
20 µL T10E0.1 buffer

3✕
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Preparation
Guidelines

While preparing the standards, keep in mind that:

• DNA quantification standards are critical for accurate analysis 
of run data

• Any mistakes or inaccuracies in making the dilutions directly 
affect the quality of results

• The quality of pipettors and tips and the care used in measuring 
and mixing dilutions affect accuracy

Preparing the
DNA Quantifica-

tion Standards

If you use T10E0.1 Buffer:
• With glycogen, you can store the prepared DNA quantification 

standards for up to 2 weeks at 2 to 8 °C.
• Without glycogen, long-term stability of the prepared DNA 

quantification standards may not be assured.

To prepare the DNA quantification standards dilution series:

1. Label eight microcentrifuge tubes: Std. 1, Std. 2, Std. 3, and 
so on.

2. Dispense the required amount of diluent (T10E0.1 Buffer with 
or without glycogen) to each tube.

3. Prepare Std. 1:

a. Vortex the Quantifiler Human DNA Standard 
3 to 5 seconds.

b. Using a new pipette tip, add the calculated amount of 
Quantifiler Human DNA Standard to the tube for Std. 1.

c. Mix the dilution thoroughly.

4. Prepare Std. 2 through 8:

a. Using a new pipette tip, add the calculated amount of 
the prepared standard to the tube for the next standard.

b. Mix the standard thoroughly.

c. Repeat steps 4a and 4b until you complete the dilution 
series.
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Preparing the Reactions

Required
Materials

• Quantifiler® Human Primer Mix or Quantifiler® Y Human Male 
Primer Mix

• Quantifiler® PCR Reaction Mix
• 10-mL polypropylene tube
• 96-well reaction plate
• Extracted DNA samples
• DNA quantification standards dilutions series
• T10E0.1 Buffer (with or without glycogen for negative controls)
• Optical Adhesive Cover

Preparing the
Reactions

While preparing the reactions, keep the 96-well reaction plate in its 
base and do not place it on the counter.

To prepare the reactions:

1. Calculate the volume of each component needed to prepare 
the reactions, using the table below.

Note: Include additional reactions in your calculations to 
provide excess volume for the loss that occurs during reagent 
transfers.

CHEMICAL HAZARD. Quantifiler 
PCR Reaction Mix may cause eye and skin irritation. 
Exposure may cause discomfort if swallowed or inhaled. 
Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Component Volume Per 
Reaction (µL)

Quantifiler Human Primer Mix or Quantifiler Y 
Human Male Primer Mix

10.5

Quantifiler PCR Reaction Mix 12.5
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2. Prepare the reagents:
• Thaw the primer mix completely, then vortex 

3 to 5 seconds and centrifuge briefly before opening the 
tube.

• Swirl the Quantifiler PCR Reaction Mix gently before 
using. Do not vortex it.

3. Pipette the required volumes of components into an 
appropriately sized polypropylene tube.

4. Vortex the PCR mix 3 to 5 seconds, then centrifuge briefly.

5. Dispense 23 µL of the PCR mix into each reaction well.

6. Add 2 µL of sample, standard, or control to the appropriate 
wells. For plate setup examples, see page 2-8, page 2-9, 
page 2-29, and page 2-30.

IMPORTANT! Applied Biosystems recommends running 
duplicates of the eight DNA quantification standards for 
each assay and on each reaction plate (see page 3-4).

7. Seal the reaction plate with the Optical Adhesive Cover.

8. Centrifuge the plate at 3000 rpm for about 20 seconds in a 
tabletop centrifuge with plate holders to remove any bubbles.

Note: If a tabletop centrifuge with 96-well plate adapters is 
not available, this step can be omitted.

9. If you are using a 7000 or 7900HT instrument, place the 
compression pad over the Optical Adhesive Cover with the 
gray side down and the brown side up and with the holes 
positioned directly over the reaction wells.

IMPORTANT! Do not use a compression pad if you are using 
a 7500 instrument.

To prepare the reactions: (continued)
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Running the Reactions

Before You Run
the Reactions

Before you run the reactions, make sure that you have:

• Powered on the SDS instrument, computer, and software:
– For 7000 SDS setup procedures, see page 2-5
– For 7900HT SDS setup procedures, see page 2-27

• Set up a plate document for the run:
– For 7000 SDS software procedures, see page 2-7
– For 7900HT SDS software procedures, see page 2-31

Running the Plate
on the 7000 SDS

To run the plate on the 7000 SDS:

1. Lift the handle at the bottom of the door on the front of the 
instrument until the door is raised completely. Gently push 
the carriage back until it stops and locks into place.

2. Position the plate in the instrument thermal block so that:
• Well A1 is in the upper-left corner
• The notched corner of the plate is in the upper-right 

corner

Lift handle to open

Do not push here to open
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3. Gently push then release the carriage to unlatch it. The 
carriage automatically slides forward into position over the 
sample plate.

4. After the door moves to the front, pull the handle down into 
place to close the cover.

Do not pull the door handle to move the 
carriage forward. This may cause serious damage to the door 
or the door mechanism.

PHYSICAL INJURY HAZARD. 
During instrument operation, the temperature of the heated 
cover can be as high as 108 °C, and the temperature of the 
sample block can be as high as 100 °C. Before performing 
the procedure, keep hands away until the heated cover and 
sample block reach room temperature.

5. In the SDS software, open the plate document that you set up 
for the run.

6. Select the Instrument tab, then click Start.

To run the plate on the 7000 SDS: (continued)

Do not pull the door forward 
by the handle

Gently push carriage back 
and release
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Running the Plate
on the

7900HT SDS

To run the plate on the 7900HT SDS:

1. In the SDS software, select the Instrument tab for the plate 
document.

2. In the Real-Time tab, click Open/Close to rotate the 
instrument tray to the OUT position.

3. Place the plate in the instrument tray so that:
• Well A1 is in the upper-left corner
• The notched corner is in the upper-right corner

4. Click Start to rotate the instrument tray to the IN position 
and to start the run.

Note: The instrument may pause to allow the heated cover to 
heat to the appropriate temperature before beginning the run.

The SDS software collects and saves the run data and the 
Real-Time tab displays the instrument status and run 
progress.

5. After the run is complete, remove the plate from the 
instrument:

a. Click Open/Close in the Instrument tab of the plate 
document that is open and connected to the 7900HT 
instrument. The instrument tray rotates to the OUT 
position.

b. Remove the plate from the instrument.

c. Click Open/Close in the Instrument tab to rotate the 
instrument tray to the IN position.
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4Data Analysis and Results 4

This chapter covers:

Section 4.1 7000 SDS Data Analysis  . . . . . . . . . . . . . . . . . . . . . .4-3
Analyzing the Plate Document . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3
Viewing Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4
Section 4.2 7900HT SDS Data Analysis. . . . . . . . . . . . . . . . . . . .4-7
Analyzing the Plate Document . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-7
Viewing Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-8
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Section 4.1 7000 SDS Data Analysis

Analyzing the Plate Document
Analyze a run after it is complete and reanalyze after you make any 
changes to the plate document, such as sample names.

To analyze a plate document:

1. Open the plate document to analyze.

2. Verify the analysis settings:

a. Select Analysis > Analysis Settings to open the 
Analysis Settings dialog box.

b. Verify that the settings are as shown below, then click 
OK.

IMPORTANT! If the analysis settings differ from those 
shown here, change them to match the settings before 
clicking OK.

3. Select Analysis > Analyze.
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Viewing Results

Overview Viewing the results of data analysis can involve one or more of the 
following:

• Viewing the Standard Curve (page 4-4)
• Viewing the Amplification Plot (page 4-5)
• Viewing the Report (page 4-5)
• Printing or Exporting the Report (page 4-6)

Viewing the
Standard Curve

For information about interpreting and troubleshooting the standard 
curve, see “Examining the Standard Curve” on page 5-4 and 
“Troubleshooting the Standard Curve” on page 5-6.

Amplification Plot
Results

The amplification plot can display one of the following:

• Plot of normalized reporter signal (Rn) versus cycle number for 
each reaction

• CT versus well position on the assay plate

For more information about the amplification plot, see “Real-Time 
Data Analysis” on page 1-10.

To view the standard curve:

1. In the Results tab, select the Standard Curve tab.

2. In the Detector drop-down list, select the detector that 
corresponds to the kit that you are using:

• Quantifiler Human or

• Quantifiler Y

3. View the CT values for the quantification standard reactions 
and the calculated regression line, slope, y-intercept, and R2 
values.
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Viewing the
Amplification Plot

For troubleshooting information, see “Troubleshooting Amplification 
Plots” on page 5-12.

Viewing the
Report

The report summarizes the quantity of DNA present in the samples. 
For information about the quantities reported, see “Assessing 
Quantity” on page 5-16.

To view the amplification plot:

1. In the Results tab, select the Amplification Plot tab.

2. In the Detector drop-down list, select a detector:
• Quantifiler Human or Quantifiler Y
• IPC

3. Select the appropriate samples in the table below the 
amplification plot.

4. Make sure that the Threshold is set to 0.20, the default 
setting.

Note: If you move the threshold bar, it changes from green 
to red to indicate reanalysis is needed. After reanalysis, it 
changes from red to green.

To view the report:

1. In the analyzed plate document, select the Results tab, then 
select the Report tab.

2. Select the reactions in the 96-well plate representation below 
the report to display the results in the report.

3. View the Qty column to determine the quantity of DNA in 
each sample.

Note: Quantities are calculated only if quantification 
standards were run and set up correctly in the software. 
Otherwise, only CT values are shown.
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Printing or
Exporting the

Report

For more information about exporting data, see the ABI PRISM® 7000 
Sequence Detection System User Guide (PN 4330228).

To print or export the report:

1. In the Report tab of the Results window, select Tools > 
Report Settings, then set up how the report is printed and 
exported:

2. • Select File > Print to print the report.
• Select File > Export to export the report as tab-

delimited text.

Note: You can later open the exported file using 
spreadsheet software.
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Section 4.2 7900HT SDS Data Analysis

Analyzing the Plate Document
Analyze a run after it is complete and reanalyze the run:

• Each time that you open a plate document to convert the saved 
raw data into analyzed data

• After you make changes to the plate document, such as sample 
names

To analyze the plate document:

1. Open the plate document to analyze.

2. Verify the analysis settings:

a. Select Analysis > Analysis Settings to open the 
Analysis Settings dialog box.

b. Verify that the settings are as shown below, then click 
OK:

IMPORTANT! If the analysis settings differ from those 
shown here, change them to match the settings before 
clicking OK.

3. Select Analysis > Analyze for the software to convert the 
raw data to analyzed data.

4. Select the Results tab to view the results.
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Viewing Results

Overview Viewing the results of data analysis can involve one or more of the 
following:

• Viewing the Standard Curve (page 4-8)
• Viewing the Amplification Plot (page 4-9)
• Viewing the Results Table (page 4-9)
• Printing the Results (page 4-10)
• Exporting the Results (page 4-10)

Viewing the
Standard Curve

For information about interpreting and troubleshooting the standard 
curve, see “Examining the Standard Curve” on page 5-4 and 
“Troubleshooting the Standard Curve” on page 5-6.

Amplification Plot
Results

The amplification plot can display one of the following:

• Plot of normalized reporter signal (Rn) versus cycle number for 
each reaction

• CT versus well position on the assay plate

For more information about the amplification plot, see “Real-Time 
Data Analysis” on page 1-10.

To view the standard curve:

1. In the Results tab, select the Standard Curve tab.

2. In the Detector drop-down list, select the detector that 
corresponds to the kit that you are using:

• Quantifiler Human or

• Quantifiler Y

3. View the CT values for the quantification standard reactions 
and the calculated regression line, slope, intercept, and R2 
values.
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Viewing the
Amplification Plot

For troubleshooting information, see “Troubleshooting Amplification 
Plots” on page 5-12.

Results Table The results table displays:

• Well position of samples
• Sample names
• Detector assignments
• Task assignments
• CT values
• Quantity
• Mean and standard deviation for CT values and Quantity, if 

replicate groups were defined in assay setup

Viewing the
Results Table

View the Qty column to determine the quantity of DNA present in 
each sample.

Note: Units for calculated quantities are not displayed but are the 
same as those specified for the quantification standards when you set 
up the plate document.

Note: Quantities are calculated only if quantification standards were 
run and set up correctly in the software. Otherwise, only CT values 
are shown.

For more information about the quantities reported, see “Assessing 
Quantity” on page 5-16.

To view the amplification plot:

1. After the run is finished, select the Results tab, then select 
the Amplification Plot tab.

2. In the Detector drop-down list, select the detector:
• Quantifiler Human or Quantifiler Y
• IPC

3. Select the appropriate samples in the 96-well grid or the 
sample table to the left of the amplification plot.

4. Make sure that the Threshold is set to 0.20, the default 
setting.
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Printing the
Results

Exporting the
Results

You can export the results in tab-delimited (*.txt) format and later 
open the exported files using spreadsheet software.

To print the results:

1. Select File > Print Report.

2. Select the data to include in the report by selecting the 
corresponding boxes for:

• Document Information
• Thermal Cycler Conditions
• Detector Information
• Well Status Summary
• Raw Data Plot
• Multicomponent Data Plot
• Amplification Plot

3. Click Page Setup, then select:
• Header/footer information and placement
• Layout orientation and size

4. Click Print to print the report.

To export the results:

1. Select File > Export.

2. Select the results to export:
• Setup Table
• Results Table
• Multicomponent
• Clipped

3. Select whether you want to export data from all wells or 
selected wells.

4. Select the SDS format of data to export.

5. Select Group by replicates if you want the replicates to be 
grouped together in the exported results.
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6. Locate, then select the folder where you want to save the 
exported results file.

7. Enter the File Name, then click Export.

To export the results: (continued)
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Checking Analysis Settings
The validity of the results requires correct analysis settings.

Checking
Analysis Settings
on the 7000 SDS

To check analysis settings on the 7000 SDS:

1. If the SDS software is not already started, select Start > 
Programs > ABI Prism 7000 > ABI Prism 7000 SDS 
Software.

2. Select File > Open.

3. Locate the plate document for the assay run of interest, select 
it, then click Open.

4. Select Analysis > Analysis Settings.

5. For all detectors, confirm that the settings are as shown 
below:

6. If the analysis settings differ from those shown in step 5:

a. Change the settings to match those in step 5.

b. Click Apply.

c. Click OK & Reanalyze to close the dialog box and 
reanalyze the plate document.

d. View the results using Chapter 4, “Data Analysis and 
Results.” 
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Checking
Analysis Settings

on the 7900HT
SDS

To check analysis settings on the 7900HT SDS:

1. If the SDS software is not already started, select Start > 
Programs > Applied Biosystems > SDS 2.0.

2. Select File > Open.

3. Locate the plate document for the assay run of interest, select 
it, then click Open.

4. Select Analysis > Analysis Settings and confirm that the 
settings are as shown below:

5. If the analysis settings differ from those shown in step 4:

a. Change the settings to match those in step 4.

b. Click OK.

c. Select Analysis > Analyze for the software to reanalyze 
the data.

d. View the results using Chapter 4, “Data Analysis and 
Results.” 
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Examining the Standard Curve
Examine the standard curve results to evaluate the quality of the 
results from the quantification standard reactions.

About Standard
Curve Results

The standard curve is a graph of the CT of quantification standard 
reactions plotted against the starting quantity of the standards. The 
software calculates the regression line by calculating the best fit with 
the quantification standard data points. The regression line formula 
has the form:

CT = m [log (Qty)] + b

where m is the slope, b is the y-intercept, and Qty is the starting DNA 
quantity. The values associated with the regression analysis can be 
interpreted as follows:

• R2 value – Measure of the closeness of fit between the standard 
curve regression line and the individual CT data points of 
quantification standard reactions. A value of 1.00 indicates a 
perfect fit between the regression line and the data points.

• Regression coefficients:
– Slope – Indicates the PCR amplification efficiency for the 

assay. A slope of −3.3 indicates 100% amplification 
efficiency.

– Y-intercept – Indicates the expected CT value for a sample 
with Qty = 1 (for example, 1 ng/µL)

R2 Value An R2 value ≥ 0.99 indicates a close fit between the standard curve 
regression line and the individual CT data points of quantification 
standard reactions

If the R2 value is <0.98 check the following:

• Quantity values entered for quantification standards in the Well 
Inspector during plate document setup

• Making of serial dilutions of quantification standards
• Loading of reactions for quantification standards
• Failure of reactions containing quantification standards
• CT value for Std. 8 of the DNA quantification standard 

(23 pg/µL), if using the Quantifiler® Y kit
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R2 Value < 0.98
for Quantifiler Y

Kit Only

If the R2 value is <0.98 for the Quantifiler Y kit only, you may choose 
to omit Std. 8 of the DNA quantification standard (23 pg/µL) from 
analysis.

At the lowest concentration point, there are only 7 to 8 copies per 
2 µL reaction of the haploid target locus for the Quantifiler Y kit. 
Because of stochastic effects when using the lowest concentration 
point with Quantifiler Y kits, the CT values are more variable at the 
lowest concentration point and may affect the closeness of fit 
between the standard curve regression line and the individual data 
points of the quantification standard.

Slope A slope close to −3.3 indicates optimal, 100% PCR amplification 
efficiency.

If the slope varies beyond the typical range indicated in Table 5-1, 
check the following:

• Assay setup
• Software setup
• Reagents
• Instrument

To omit Std. 8 from analysis (for Quantifiler Y kits only):

1. Select the wells in the plate document that correspond to Std. 
8 and open the Well Inspector.

2. Change the Task assignment for the Quantifiler Y detector 
from Standard to Unknown.

3. Reanalyze the plate to incorporate the change.

Table 5-1 Range and average of standard curve slope values

Kit Typical Slope (range) Average Slope

Quantifiler Human −2.9 to −3.3 −3.1

Quantifiler Y −3.0 to −3.6 −3.3
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Troubleshooting the Standard Curve
Table 5-2 Troubleshooting the standard curve

Observation Possible Cause Recommended Action

Slope for the standard curve 
differs significantly from −3.33 
or

R2 value significantly less than 
0.98 to 0.99

When applying detectors for 
standards, the Task and 
Quantity were applied to the 
wrong detector (see “Example 
1” on page 5-7).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that the Task and 
Quantity were applied to the 
correct detector and 
reanalyze.

When applying detectors for 
the standards, the incorrect 
Quantity was entered (see 
“Example 2” on page 5-8).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that the correct 
Quantity was entered and 
reanalyze.

Stochastic effects when using 
the lowest concentration point 
with the Quantifiler Y kit.

Omit Std. 8 of the DNA 
quantification standard 
(23 pg/µL) from analysis.

At each concentration in the 
standard curve:

• There are four replicates
• There is a large difference in 

CT between the replicates

Note: This observation applies 
only when Quantifiler Human kit 
reactions and Quantifiler Y kit 
reactions are run together on 
the same reaction plate.

The same detector was applied 
for the Quantifiler Human kit 
standard reactions and for the 
Quantifiler Y kit standard 
reactions (see “Example 3” on 
page 5-9).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that the correct 
detector is in use and that 
the Task and Quantity were 
applied to the correct 
detector and reanalyze.
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The examples shown in the following sections can be caused by 
errors made in applying the detectors for standards when setting up 
the plate document. For instructions on how to apply the detectors for 
standards, see:

• Page 2-15 (7000 SDS)
• Page 2-35 (7900HT SDS)

Note: The standard curves shown in these examples are not optimal 
and should not be used.

Example 1 Observation

Almost all of the CT values for the DNA quantification standard 
reactions lie outside of the standard curve and form a straight 
horizontal line.
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Possible Cause

When applying detectors for the standards, the Task and Quantity 
were applied to the IPC detector instead of to the Quantifiler Human 
detector.

Example 2 Observation

One point lies outside of the standard curve.

Possible Cause

When applying detectors for the standards, the incorrect Quantity 
was entered. In the example shown above, 0.062 was entered for the 
Quantity instead of 0.62.

Task and 
Quantity 
applied 
to wrong 
detector

Outlier
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Example 3 Observation

At each concentration in the standard curve:

• There are four replicates
• There is a large difference in the CT between the replicates

Possible Cause

The Quantifiler® Human kit assay and the Quantifiler® Y kit assay 
were performed on the same reaction plate and when applying 
detectors for standards, the same detector was applied for Quantifiler 
Human kit standard reactions and for the Quantifiler Y kit standard 
reactions.

Incorrect 
Quantity 
entered 
for 
standard
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Using the Internal PCR Control System

Purpose Use the Internal PCR Control (IPC) system to distinguish between 
true negative sample results and reactions affected by:

• The presence of PCR inhibitors
• Assay setup
• A chemistry or instrument failure

Components The following components of the IPC system are present in the 
Quantifiler PCR mix:

• Synthetic DNA template
• Primers that hybridize specifically to the synthetic DNA 

template
• Probe labeled with VIC® dye

Interpreting IPC
Results

In the amplification plot window of the SDS software, observe 
amplification of the FAM™ dye (Quantifiler Human detector or 
Quantifiler Y detector) and the VIC® dye (IPC detector), then use 
Table 5-3 to interpret the IPC results.

Note: Positive amplification is when the CT value for the detector is 
<40. Because samples contain unknown amounts of DNA, a large 
range of CT values is possible. Because the IPC system template 
DNA is added to the reaction at a fixed concentration, the CT VIC 
should range from 20 to 30.

Table 5-3 Interpreting IPC amplification results

Quantifiler Human or 
Quantifiler Y (FAM Dye) IPC (VIC Dye) Interpretation

No amplification Amplification True negative

No amplification No amplification Invalid result

Amplification
(low CT and high ∆Rn)

No amplification Disregard IPC result

Amplification
(high CT and low ∆Rn)

No amplification Partial PCR inhibition
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True Negative
Results

With a true negative result:

• FAM dye signal indicates that the human-specific target failed to 
amplify

• VIC dye signal (CT VIC between 20 and 30) indicates that the IPC 
target was amplified; so, the PCR was not inhibited

Invalid IPC
Results

If the human-specific target and the IPC target failed to amplify, it is 
not possible to distinguish between the absence of DNA and PCR 
inhibition.

Disregarding IPC
Results

With extremely high concentrations of human genomic DNA 
(>10 ng/µL), competition between the human-specific and IPC PCR 
reactions appears to suppress IPC amplification for that sample. If 
the target amplifies with low CT and high ∆Rn results, it is unlikely 
that PCR inhibitors are present. In these cases, appearance of 
suppression or failure of IPC amplification can be disregarded.

Partial PCR
Inhibition

Weak amplification (high CT value and low ∆ Rn value) of the human 
target and no amplification of the IPC may indicate partial PCR 
inhibition in the sample.

Determining the
Normal Range for

IPC

To determine the normal range of CT values for the IPC, view the 
VIC dye signal in the amplification plots for the quantification 
standards. If the assays were set up properly and the buffer used to 
dilute the quantification standards was free of PCR inhibitors, the 
reactions should show normal IPC amplification across a broad range 
of input DNA.

Evaluating PCR
Inhibition

If the IPC amplification for certain samples appears reduced relative 
to IPC amplification for quantification standards, the decreased IPC 
amplification may be interpreted as partial PCR inhibition. The IPC 
results can help you decide the next step:

• Proceed directly to an STR assay of the sample
• Repeat the DNA extraction from the sample
• Perform additional cleanup of the sample
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Assessing Quantity

Purpose After viewing the results and assessing the quality of the results, the 
analyst should determine whether sufficient DNA is present to 
proceed with a short tandem repeat (STR) assay.

Assay Sensitivity Quantifiler kit assays can detect < 23 pg/µL of human genomic DNA 
in samples. For samples loaded at 2.0 µL per reaction, this 
concentration corresponds to < 13 copies of the Quantifiler Human 
target DNA and < 7 copies of the Quantifiler Y target locus (Y 
chromosome loci are haploid).

Stochastic
Effects

In the 23-pg/µL concentration range, stochastic effects, or the 
statistical effect of sampling low-copy loci, may cause significant 
variability in assay results.

Validity The detection and quantification of low-copy DNA samples with the 
Quantifiler kits is valid. However, the amounts present in the sample 
may be below the working range of certain genotyping methods.

If Insufficient
DNA Is Present

If the results from Quantifiler kit reactions indicate that insufficient 
DNA is present to perform an STR assay, the analyst may decide to:

• Extract the DNA again, then repeat the test with the Quantifiler 
kit before performing STR analysis

• Concentrate the sample, then repeat the test with the Quantifiler 
kit before performing STR analysis
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Overview

About This
Chapter

This chapter provides results of the validation experiments performed 
by Applied Biosystems using the Quantifiler® Human DNA 
Quantification Kit and the Quantifiler® Y Human Male DNA 
Quantification Kit.

Importance of
Validation

Although the Quantifiler kits are not DNA genotyping assays, they 
are intended for use before performing genotyping assays such as the 
AmpFlSTR® PCR Amplification kits. By testing the procedure with 
samples commonly encountered in forensic and parentage 
laboratories, the validation process clarifies attributes and limitations 
that are critical for sound data interpretation in casework.

Experiments Experiments to evaluate the performance of the Quantifiler kits were 
performed at Applied Biosystems, according to the DNA Advisory 
Board (DAB) Quality Assurance Standards For Forensic DNA 
Testing Laboratories (DAB, 1998). These DAB standards describe 
the quality assurance requirements that a laboratory should follow to 
ensure the quality and integrity of the data and competency of the 
laboratory. The DAB defines a laboratory as a facility in which 
forensic DNA testing is performed. Additional validation was 
performed according to guidelines from the Scientific Working 
Group on DNA Analysis Methods (SWGDAM).

The experiments focused on kit performance parameters relevant to 
the intended use of the kits as human-specific DNA quantification 
assays and as a part of a forensic DNA genotyping procedure.

Each laboratory using the Quantifiler® Human DNA Quantification 
Kit or the Quantifiler® Y Human Male DNA Quantification Kit 
should perform appropriate validation studies.
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Section 6.1 ABI PRISM® 7000 Sequence 
Detection System Validation 
(SDS Software v1.0)

DAB (DNA Advisory Board) Guideline 8.1.1

“Developmental validation that is conducted shall be appropriately 
documented.” (DAB, 1998).

DAB Guideline 8.1.2

“Novel forensic DNA methodologies shall undergo developmental 
validation to ensure the accuracy, precision and reproducibility of the 
procedure.” (DAB, 1998).
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6.1.1  Precision

The precision of the Quantifiler® Human kit and the Quantifiler® Y 
kit was tested by performing runs on different instruments and on 
different days.

Experiment One set of eight serial dilutions of the Quantifiler Human DNA 
Standard was prepared. The dilutions ranged from 50 ng/µL to 
23 pg/µL in three-fold increments.

Three different reaction plates were prepared and each plate 
contained duplicate reactions of the dilutions using the Quantifiler 
Human kit and the Quantifiler Y kit.

The three plates were run on three different 7000 SDS instruments, 
using standard thermal cycler conditions for the Quantifiler kits. The 
multiple runs were performed on two different days, using the same 
three 7000 SDS instruments.

The CT FAM values were recorded and the means and standard 
deviations of the CT FAM values were calculated for each of the eight 
dilutions using the Quantifiler Human kit and the Quantifiler Y kit.

Results Table 6-1 shows the means and standard deviations of the CT FAM 
values calculated for all 12 reactions of each quantification standard 
dilution for the Quantifiler Human and Quantifiler Y kits.

Table 6-1 Precision: CT values

Quantification 
Standard Dilution 

(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

CT (Mean) Standard 
Deviation CT (Mean) Standard 

Deviation

50 23.09 0.10 23.94 0.21

16.7 24.64 0.17 25.38 0.17

5.56 26.19 0.16 26.91 0.13

1.85 27.67 0.17 28.35 0.15

0.62 29.09 0.17 29.84 0.26

0.21 30.31 0.19 31.38 0.31
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Figure 6-1 and Figure 6-2 show the CT FAM results for all 8 
quantification standard dilutions reactions using the Quantifiler 
Human kit and the Quantifiler Y kit.

Figure 6-1 Precision using the Quantifiler Human kit

0.068 31.90 0.28 33.38 0.44

0.023 33.45 0.48 35.19 0.73

Table 6-1 Precision: CT values (continued)

Quantification 
Standard Dilution 

(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

CT (Mean) Standard 
Deviation CT (Mean) Standard 

Deviation

Day 1 Day 2

Instruments
1 2 3 1 2 3

Mean

16.7 5.56 0.62 0.06850

DNA quantity (ng/µL)

40

35

30

25

20

15

10

C
T

5

0
0.0231.85 0.21
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Figure 6-2 Precision using the Quantifiler Y kit

The data show that at lower DNA concentrations, the CT values 
increased and the standard deviation increased, most likely because 
of stochastic effects.

For each sample, the CT values obtained using the Quantifiler Human 
kit are lower than those obtained using the Quantifiler Y kit because 
there are two copies of the autosomal human target locus and only 
one copy of the Y chromosome target locus.

The CT values do not vary significantly from run to run or from 
instrument to instrument. The CT value from one sample run on three 
different 7000 instruments varies with an average standard deviation 
of 0.3. Systematic differences between instruments, which are 
normally insignificant, are not expected to affect final sample 
quantification results because, when samples and quantification 
standards are run on the same plate and instrument, the CT values are 
affected equally.

Day 1 Day 2

Instruments
1 2 3 1 2 3

Mean

16.7 5.56 0.62 0.06850

DNA quantity (ng/µL)
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C

T 
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0
0.0231.85 0.21
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6.1.2  Reproducibility

Experiment Six different human DNA samples were tested for reproducibility of 
the quantification results.

Using the concentrations provided by the supplier, the DNA samples 
were diluted to 2.0 ng/µL (A), 0.5 ng/µL (B), and 0.1 ng/µL (C).

Note: All dilutions were made in T10E0.1 Buffer with 20 µg/mL 
glycogen added as a carrier and stabilizer.

All samples and dilutions were tested in successive runs using the 
Quantifiler Human kit and the Quantifiler Y kit. Three different runs 
were performed. Each assay contained two reactions for each of the 
quantification standards and one reaction for each of the samples.

For each sample reaction the CT FAM values were obtained and the 
DNA quantity calculated. The mean quantity and standard deviations 
were calculated for each sample. The 95% confidence interval values 
were calculated as the mean of the DNA quantity ± two standard 
deviation units for each sample and expressed as a percentage of the 
mean quantification result. 

Table 6-2 Human DNA samples tested for reproducibility

DNA Sex Extraction Source

007 Male Blood

9948 Male Cell line

Human genomic Male Blood

Raji (Lot 1) Male Cell line

Raji (Lot 2) Male Cell line

K-562 Female Cell line
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Results The following tables show the DNA quantity calculated for all 
samples and dilutions tested for all three runs using the Quantifiler 
Human kit (Table 6-3) and the Quantifiler Y kit (Table 6-4).

Table 6-3 Reproducibility using the Quantifiler Human kit

Sample
DNA Quantity (ng/µL)

Standard 
Deviation

95% 
Confidence 
(± percent)Run 1 Run 2 Run 3 Mean

007 A 2.580 2.830 2.900 2.770 0.168 12.15

007 B 0.894 0.779 0.892 0.855 0.066 15.40

007 C 0.216 0.160 0.192 0.189 0.028 29.68

9948 A 2.300 2.240 2.210 2.250 0.046 4.07

9948 B 0.504 0.481 0.573 0.519 0.048 18.44

9948 C 0.123 0.132 0.132 0.129 0.005 8.06

Human genomic A 1.810 1.790 2.240 1.947 0.254 26.12

Human genomic B 0.495 0.468 0.504 0.489 0.019 7.66

Human genomic C 0.128 0.106 0.106 0.113 0.013 22.41

K-562 A 1.360 1.350 1.360 1.357 0.006 0.85

K-562 B 0.379 0.425 0.460 0.421 0.041 19.28

K-562 C 0.096 0.126 0.096 0.106 0.017 32.42

Raji-1 A 1.920 1.800 1.770 1.830 0.079 8.67

Raji-1 B 0.484 0.402 0.466 0.451 0.043 19.13

Raji-1 C 0.149 0.120 0.104 0.124 0.023 36.69

Raji-2 A 1.720 1.860 1.700 1.760 0.087 9.91

Raji-2 B 0.419 0.407 0.408 0.411 0.007 3.24

Raji-2 C 0.113 0.088 0.061 0.087 0.026 59.50
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Table 6-4 Reproducibility using the Quantifiler Y kit

Sample
DNA Quantity (ng/µL)

Standard 
Deviation

95% 
Confidence

Run 1 Run 2 Run 3 Mean

007 A 3.760 3.600 3.840 3.733 0.122 6.55

007 B 1.180 0.898 1.040 1.039 0.141 27.13

007 C 0.238 0.185 0.172 0.198 0.035 35.26

9948 A 2.590 2.540 2.670 2.600 0.066 5.04

9948 B 0.810 0.612 0.709 0.710 0.099 27.88

9948 C 0.146 0.130 0.151 0.142 0.011 15.41

Human genomic A 2.010 1.770 1.760 1.847 0.142 15.33

Human genomic B 0.577 0.462 0.591 0.543 0.071 26.06

Human genomic C 0.081 0.053 0.052 0.062 0.017 54.04

K-562 A — — — n.d.a n.d. n.d.

K-562 B — — — n.d. n.d. n.d.

K-562 C — — — n.d. n.d. n.d.

Raji-1 A 2.500 2.090 2.400 2.330 0.214 18.35

Raji-1 B 0.679 0.481 0.565 0.575 0.099 34.57

Raji-1 C 0.123 0.096 0.148 0.122 0.026 42.80

Raji-2 A 2.630 2.050 2.190 2.290 0.303 26.43

Raji-2 B 0.574 0.536 0.612 0.574 0.038 13.24

Raji-2 C 0.091 0.123 0.160 0.125 0.034 55.02

a. n.d. = not determined
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The 95% confidence interval shows the approximate range expected 
for results when using the Quantifiler kits. The average 95% 
confidence interval for each kit:

• Quantifiler Human kit: ±18.5%
• Quantifiler Y kit: ±26.9%

The data show that as the DNA concentration decreases, the amount 
of variability in the quantification results increases. This results from 
stochastic effects—the statistical principles involved when testing 
DNA samples with low concentrations. Stochastic effects may cause 
imbalance or dropouts of alleles when performing STR analysis of 
DNA samples with low concentrations.

6.1.3  Specificity with a Human DNA Panel

Purified genomic DNA samples from 500 human individuals were 
obtained from two different commercial sources. Many of the 
samples were extracted from cell lines that provide distinct genotypes 
for forensic validation work; other samples were extracted from 
blood specimens. The sex of all samples was confirmed by genotypic 
analysis using the AmpFlSTR® Identifiler® PCR Amplification Kit 
(amelogenin locus).

Experiment Approximately 20 to 40 ng of purified genomic DNA from the 
Human DNA Panel was used for each Quantifiler kit reaction.

Sequence Detection Systems (SDS) software was used to analyze the 
data and calculate the CT FAM value:

CT FAM Value Result

CT FAM <40 +

No amplification after 40 cycles −
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Results The results in Table 6-5 show that:

• The Quantifiler Human kit detected all 500 human DNA 
samples.

• The Quantifiler Y kit detected all 240 male DNA samples and 
none of the female DNA samples.

6.1.4  Specificity with a Non-Human Panel

Samples were obtained either as purified DNA or as whole blood 
from individual animals. For some of the purified DNA samples, the 
sex of the donor animals was unknown; for remaining samples, the 
sex and identity of the animals was known. For some species, 
multiple individuals were tested.

Experiment For many of the reactions, approximately 0.25 to 1.0 ng of DNA was 
used in each reaction. For a few reactions, up to 40 ng of DNA was 
used in one reaction.

SDS software was used to analyze the data and calculate the CT FAM 
value:

Table 6-5 Specificity with human DNA panel

Sex
Result

Quantifiler Human Kit Quantifiler Y Kit

Male (240) + +

Female (260) + −

CT FAM Value Result

CT FAM <40 +

No amplification after 40 cycles −
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Results The two human control samples that were tested show expected 
results (as shown in Table 6-5 on page 6-11).

Quantifiler Human Kit Results

The Quantifiler Human kit detected DNA from humans and apes, 
with some less-efficient detection of one other primate. The 
Quantifiler Human kit:

• Detected DNA from all of the higher ape DNA samples 
(chimpanzee, gorilla, and orangutan) at an efficiency similar to 
that of humans

• Detected DNA from macaque monkeys at a significantly 
reduced efficiency, possibly because of partial homology 
between the primers and probe and the macaque DNA

• Did not detect DNA from the remaining species

Quantifiler Y Kit Results

The Quantifiler Y kit detected DNA from male humans and 
chimpanzees but from no other species tested.

Of the DNA samples that were detected using the Quantifiler Human 
Kit (gorilla, chimpanzee, orangutan, and macaque), the Quantifiler Y 
kit:

• Detected DNA from the chimpanzees
• Did not detect DNA from the male gorilla
• Did not detect DNA from the female orangutans or macaques 

Table 6-6 Specificity with non-human panel

Organism Sex

Result

Quantifiler 
Human Kit

Quantifiler Y 
Kit

Gorillla (2) Femalea + −

Chimpanzee (2) Unknown + +

Orangutan (2) Femalea + −

Macaque (2) Femalea ±b −
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Cat Unknown − −

Dog Unknown − −

Pig Unknown − −

Cow Unknown − −

Mouse Unknown − −

Rabbit Unknown − −

Hamster Unknown − −

Rat Unknown − −

Chicken Unknown − −

Fish Unknown − −

Gorilla Male + −

Cat Male − −

Dog (2) Male − −

Mouse Male − −

Rabbit Male − −

Rat Male − −

Horse (2) Male − −

Bovine Male − −

Sheep Male − −

Pig Male − −

Deer Male − −

Table 6-6 Specificity with non-human panel (continued)

Organism Sex

Result

Quantifiler 
Human Kit

Quantifiler Y 
Kit
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6.1.5  Specificity with a Bacterial Pools Panel

The bacterial pools panel contained purified genomic DNA from 53 
bacterial species and one yeast species. The panel included:

• Common gram-negative and gram-positive species
• Species associated with the human gut (for example, Proteus, 

Providencia, Alcaligenes)
• Species associated with food (Lactobacillus spp.)
• Species associated with spoilage and decomposition (for 

example, Pseudomonas, Flavobacterium, Clostridium, 
Candida)

• Species associated with human enteric disease (for example, 
Salmonella, Escherichia coli, Yersinia). 

• Several species of Bacillus, a common and pervasive bacterial 
genus

Experiment There were approximately 1 × 105 genome copies of each species in 
each reaction.

SDS software was used to analyze the data and calculate the CT FAM 
value:

Chicken Male − −

Human Female + −

Human Male + +

a. Sex confirmed by STR analysis.
b. Weak but positive amplification with higher CT values and lower Rn values 

than normal for the input amount of DNA in the reaction.

Table 6-6 Specificity with non-human panel (continued)

Organism Sex

Result

Quantifiler 
Human Kit

Quantifiler Y 
Kit

CT FAM Value Result

CT FAM <40 +

No amplification after 40 cycles −
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Results The Quantifiler Human Kit and the Quantifiler Y kit did not detect 
DNA from any of the bacterial or yeast species tested.

Table 6-7 Specificity with bacterial pools panel

Species Composition

Result

Quantifiler 
Human Kit

Quantifiler 
Y Kit

Lactobacillus acidophilus, Lactobacillus delbrueckii (2), Lactobacillus 
rhamnosus, Lactobacillus casei

− −

Brochothrix thermosphacta, Brochothrix campestris, Aerococcus 
viridians, Kurthia gibsonii, Alcaligenes faecalis

− −

Bacillus subtilis, Bacillus cereus, Bacillus licheniformis, Bacillus 
mycoides, Bacillus stearothermophilus

− −

Pseudomonas fluorescens, Flavobacterium odoratum, Clostridium 
sporogenes, Candida kefyr (yeast), Deinococcus radiodurans

− −

Lactococcus lactis, Bordetella bronchiseptica, Acinetobacter 
baumannii, Aeromonas caviae, Corynebacterium varibile

− −

Nocardia asteroides, Stenotrophomonas maltophilia, Bacillus 
coagulans, Rhodococcus equi, Acinetobacter calcoaceticus

− −

Propionibacterium acnes, Clostridium difficile, Fusebacterium 
necrophorum, Burkholderia cepacia, Delftia acidovorans

− −

Micrococcus luteus, Streptomyces rimosus, Gordonia sputi, 
Legionella ansia, Pasteurella aerogenes

− −

Citrobacter freundii, Klebsiella pneumoniae, Escherichia hermanii, 
Enterobacter cloacae, Escherichia coli O157:H7

− −

Salmonella enteritidis, Shigella dysenteriae, Proteus vulgaris, 
Pseudomonas aeruginosa, Hafnia alvei

− −

Yersinia enterocolitica, Campylobacter coli, Providencia stuartii, 
Vibrio parahaemolyticus, Alcaligenes faecalis

− −
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6.1.6  Sensitivity

Human genomic DNA samples were obtained from different 
commercial sources. For each DNA sample, a dilution series was 
made and each dilution was tested with the Quantifiler Human kit 
and the Quantifiler Y kit.

DNA Samples
Tested

Five different human DNA samples were tested.

Experiment Using the concentrations provided by the suppliers, five-fold serial 
dilutions of the DNA samples were made. Concentrations ranged 
from 10 ng/µL to 0.016 ng/µL (16 pg/µL).

Note: All dilutions were made in T10E0.1 Buffer with 20 µg/mL 
glycogen added as a carrier and stabilizer.

For each 25-µL reaction, 2.0 µL of DNA sample was used.

Results A plot of the CT values versus the known DNA quantities showed the 
expected log-linear relationship between the two quantities. All 
dilutions, including samples at the lowest concentration (16 pg/µL), 
gave positive results for the Quantifiler Human kit and the 
Quantifiler Y kit. For each dilution series, the data points formed an 
acceptable standard curve. The small differences in CT values among 
the dilutions of different DNA samples likely reflect differences in 
the quantification measurements made by each supplier.

Table 6-8 Human DNA samples tested for sensitivity

Sample Extraction Source

007 Human male blood

9948 Human male cell line

Human genomic Human male blood

Raji Human male cell line

K-562 Human female cell line
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Figure 6-3 Sensitivity using the Quantifiler Human kit

Figure 6-4 Sensitivity using the Quantifiler Y kit

6.1.7  Stability

DNA samples from various origins are commonly contaminated with 
organic and inorganic compounds that inhibit the amplification of 
nucleic acids by PCR. These PCR inhibitors can interfere with the 
reaction and cause varying levels of reduced PCR efficiency, 
including complete inhibition of PCR. A wide variety of PCR 
inhibitors has been reported, including in DNA samples extracted 
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from blood stains. One example is hematin, which has been found in 
DNA samples extracted from blood stains. Because the solubility of 
hematin is similar to that of DNA, it is thought that it is extracted and 
purified with the DNA. The presence of hematin in DNA samples 
may interfere with PCR by inhibiting polymerase activity.

Bovine serum albumin (BSA) is used in enzymatic reactions because 
it appears to increase the efficiency of the PCR reaction, most likely 
acting as a chelating agent with many inhibitors. BSA is added to the 
Quantifiler kit and AmpFlSTR® kit reaction mixes specifically to 
counteract the presence of PCR inhibitors.

Experiment Human genomic DNA was mixed with varying concentrations of 
hematin: 0 µM, 10 µM, 12 µM, 14 µM, 16 µM, 18 µM, 20 µM, and 
40 µM. 2.0 µL of each DNA/hematin mix, containing 1.0 ng total of 
human DNA, was quantified using the Quantifiler Human kit and 
Quantifiler Y kit; the same amounts of samples were added to 
reactions using the AmpFlSTR® Identifiler® PCR Amplification Kit. 
Identifiler kit reactions were analyzed on a 3100 instrument. Data 
were analyzed with GeneScan® Software v3.7.1 and Genotyper® 
Software v3.7, for use with the Windows NT® operating system.

Results Amplification plots (Figures 6-5 and 6-6) showed lower ∆Rn values 
and higher CT values as the concentration of hematin increased. CT 
results and corresponding quantification results were relatively stable 
up to 14 µM hematin, with results more affected at higher 
concentrations. As the concentration of hematin increased, the PCR 
efficiency in the Quantifiler kit reactions and the Identifiler kit 
reactions decreased. For the Quantifiler Human kit, complete 
inhibition occurred at 40 µM, and for the Quantifiler Y kit, complete 
inhibition occurred at 18 µM, 20 µM, and 40 µM. The inhibition may 
be stronger with the Quantifiler Y kit because there is only one copy 
of the haploid Y chromosome target locus for the Quantifiler Y kit 
and two copies of the diploid autosomal target locus for the 
Quantifiler Human kit.

The IPC system is more sensitive to PCR inhibition. For the 
Quantifiler Human kit, in samples containing more than 16 µM 
hematin, amplification of IPC detectors failed. In samples containing 
less hematin, amplification of IPC detectors was inhibited 
(Figure 6-7). Although the Human detector amplified for the 16 µM, 
18 µM and 20 µM hematin samples, the failure of IPC amplification 
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in those reactions indicates that the presence of PCR inhibitors is 
likely. Because the IPC system components are the same in both 
Quantifiler kits, the IPC results for the Quantifiler Y kit were similar 
to those for the Quantifiler Human kit.

Figure 6-5 Inhibition studies: Quantifiler Human kit

Figure 6-6 Inhibition studies: Quantifiler Y kit
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Figure 6-7 Inhibition studies: IPC detector

The results of STR analysis using the Identifiler kit (Figure 6-8) were 
consistent with the results from the Quantifiler kits: as the 
concentration of hematin increased, the overall STR peak profile 
decreased. Complete STR profiles were obtained at hematin 
concentrations up to 20 µM. The STR amplification reaction was 
completely inhibited by 40 µM hematin. The results from the 
Quantifiler kits provided reasonable predictions of samples that 
would fail STR analysis because of the presence of the PCR inhibitor. 
The STR profiles for the positive and negative controls are included 
for reference.
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Figure 6-8 Inhibition studies: STR analysis
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laboratory.

0 µM

10 µM

12 µM

14 µM

16 µM

18 µM

20 µM

40 µM

[Hematin]

Positive 
control

Negative 
control



Chapter 6 Experiments and Results

6-22 Quantifiler Kits User’s Manual

Experiment Purified genomic DNA from the Raji (male) and K-562 (female) cell 
lines were mixed in ratios of 1:1, 1:4, 1:16, 1:64, 1:256 and 1:1024 
(Raji:K-562). The male DNA was added at a constant level of 
0.05 ng/µL in all samples, and the female DNA was present at 
amounts ranging from 0.05 ng/µL in the 1:1 sample to 50 ng/µL in 
the 1:1024 sample. The DNA amounts were calculated based only on 
the DNA concentrations provided by the suppliers and were not 
calibrated with the Quantifiler kits.

The mixtures were tested with the Quantifiler Human kit and the 
Quantifiler Y kit to determine the concentrations of total human 
genomic DNA (Quantifiler Human kit) and male DNA only 
(Quantifiler Y kit). For each sample, three replicate reactions were 
performed for each assay. Each assay used the same set of 8 human 
genomic DNA quantification standards run in duplicate reactions for 
each assay and both assays were run on the same reaction plate. The 
reaction plates were run on a 7000 instrument. 

Results The quantification results (Figure 6-9 on page 6-23) from using the 
Quantifiler Human kit varied from an average of 0.16 ng/µL for the 
1:1 sample to 38 ng/µL for the 1:1024 sample, consistent with the 
increasing amounts of female DNA present.

The quantification results from using the Quantifiler Y kit varied 
from between 0.034 ng/µL to 0.063 ng/µL for all samples, regardless 
of the amount of female DNA present.

For the 1:1024 sample, the results showed a ratio of male DNA to 
total DNA of 1:974. Differences between target concentrations and 
actual measurements were expected because the amounts of DNA 
added to the mixtures were based only on the DNA concentrations 
provided by the suppliers and were not calibrated with the Quantifiler 
kits.

In all samples, the male DNA was detected and quantified accurately, 
regardless of the amount of female DNA present.
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Figure 6-9 DNA quantities determined in mixture studies

6.1.9  Degraded DNA Studies

Forensic samples may be exposed to environmental conditions that 
degrade DNA molecules and reduce their amplification efficiency in 
PCR reactions. Exposure to environmental conditions can reduce the 
overall DNA concentration and may cause fragmentation of full-
length DNA molecules into smaller fragments. DNA fragmentation 
makes it difficult to amplify longer segments such as the larger STR 
loci. Because of such potential occurrences, the validation of forensic 
DNA methods often involves studies of the effects of degradation on 
the amplification and detection of DNA.

The Quantifiler® kits were tested with DNA degraded with the DNA 
nuclease DNase I. The degraded DNA samples were tested with the 
Quantifiler Human kit and the Quantifiler Y kit to determine the 
quantity of amplifiable DNA in each time point. Results obtained 
using the Quantifiler kits were used to calculate DNA input for an 
STR assay using an ABI PRISM® 3100 Genetic Analyzer.

Experiment A time-course of exposure to DNase I was performed on a sample of 
high molecular weight human genomic DNA to generate a series of 
samples with varying levels of degradation. The time points in the 
DNase I treatment were 0 minutes (untreated), 1 minute, 2 minutes, 
3 minutes, 4 minutes, 5 minutes, 15 minutes and 60 minutes. 
Samples from all time points were run on a 2% agarose gel for 25 
minutes and visualized by staining with ethidium bromide. The 

Quantifiler Y kit
Quantifiler Human kit

100.000

1.000

10.000

0.100

0.010
1:1 1:5 1:16 1:64 1:256 1:1024

Male:Female Mixture Ratio

D
N

A
 Q

ua
nt

ity
 (n

g/
µL

)



Chapter 6 Experiments and Results

6-24 Quantifiler Kits User’s Manual

treated DNA samples were examined by agarose gel electrophoresis 
to determine the average size of the DNA fragments at each time 
point. The degraded DNA samples were tested with the Quantifiler 
Human kit and the Quantifiler Y kit to determine the quantity of 
amplifiable DNA in each time point.

Using the results from the Quantifiler kits, the volumes of DNA 
required for AmpFlSTR® Identifiler® kit reactions were calculated so 
that 1.0 ng/µL was added for each reaction. The PCR products were 
run on an ABI PRISM® 3100 Genetic Analyzer.

Results Agarose gel electrophoresis showed that the DNase I treatment 
reduced the average size of DNA fragments to 100 basepairs (bp) or 
less within the first 5 minutes (Figure 6-10).

Figure 6-10 DNase I degradation of human genomic DNA

The results from the Quantifiler kits (Figures 6-11 and 6-12) showed 
higher CT values with longer DNase exposure times, corresponding 
to lower amounts of amplifiable DNA in the samples. According to 
results from the Quantifiler Human kit, the amount of amplifiable 
DNA decreased from 12.0 ng/µL to 1.2 ng/µL at the 5-minute time 
point and to 0.11 ng/µL at the 15-minute time point. At the 
60-minute time point, no amplifiable DNA was detected.
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Figure 6-11 Degraded DNA: Quantifiler Human kit amplification 
plot

Figure 6-12 Degraded DNA: Quantifiler Y kit amplification plot

Using the DNA quantification results from the Quantifiler Human 
kit, 1.0 ng of each DNA sample was added to Identifiler kit reactions. 
As the concentration of amplifiable DNA decreased because of 
degradation, the sample volume required in the reaction increased.

Identifiler kit results at 1.0 ng/µL produced complete STR profiles 
up to the 5-minute time point, although the amount of amplifiable 
DNA (according to the Quantifiler kit) was reduced by 90% relative 
to the untreated control (Figure 6-13). The peak heights were reduced 
for the more degraded samples, but profiles were still detected. The 
15-minute time point contained only 1% of the original amount of 
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amplifiable DNA and produced only a partial STR profile of mostly 
smaller molecular weight loci. At 60 minutes, no DNA was detected 
by the Quantifiler kits (Figures 6-11 and 6-12) or the Identifiler kit 
(Figure 6-13).

The Quantifiler kits can be used to report the amount of amplifiable 
DNA in a sample but not the amount of DNA degradation. Using the 
quantification data from the kits to determine the amount of sample 
input for STR analysis may help to correct for the loss of amplifiable 
DNA because of degradation, but if the level of DNA degradation is 
so high that the remaining DNA fragments are too small, the sample 
will not amplify by using the Quantifiler kits or the STR kits. 

Figure 6-13 STR analysis using degraded DNA
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6.1.10  Comparisons with Other Methods

Purified DNA samples were quantified using the Quantifiler Human 
kit and the Quantifiler Y kit. The results were compared to results 
obtained from measuring absorbance at 260 nm (A260), using a dye 
intercalation method, and using the Quantiblot® Human DNA 
Quantitation Kit (Applied Biosystems).

The methods tested show different sensitivity ranges and different 
specificities.

6.1.11  Comparison with A260 and Quantiblot Kit

The concentration of DNA was measured for 50 human genomic 
DNA samples using a A260 method, the Quantiblot kit, and the 
Quantifiler kits. The DNA quantification results were compared. 

Resolution Panel The resolution panel, a set of 50 human genomic DNA samples 
purified from blood, was tested. The samples were database type 
samples because they were extracted from blood specimens and had 
uniform high concentrations of DNA between approximately 10 and 
20 ng/µl. All samples were within the range of sensitivity for the A260 
method.

Table 6-9 Comparison: sensitivity and specificity of methods

Method Sensitivity Specificity

A260 Cannot detect DNA in the picogram 
range.

Not specific for human genomic DNA. 
Detects single-stranded DNA, 
double-stranded DNA, and RNA.

Dye intercalation 25 pg/mLa Not specific for human genomic DNA

Quantiblot kit 2 ng/µL to 0.03125 ng/µL Specific for human genomic DNA

a. Value obtained from the manufacturer’s documentation.
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Experiment Each DNA sample was quantified using:

• A260 method – Absorbance at 260 nm was measured. DNA 
concentration was calculated using the formula:

Concentration (µg/mL) = 50 × A260

• Quantiblot kit – DNA was quantified using a protocol for 
chemiluminescence detection with film autoradiography.

• Quantifiler kits – DNA was quantified using the standard 
procedure.

For each sample, the percent differences between Quantifiler kit 
results and results from the other two methods were calculated. The 
differences were expressed as a percentage of the reference method. 
For each method, the average percent differences from Quantifiler kit 
results were calculated. For comparisons with the Quantifiler Y kit, 
only results from male samples were used.

Results Table 6-10 shows the DNA quantification results for all 50 samples 
in the resolution panel and for the three methods. The table also 
shows the percent differences between the results from the 
Quantifiler kits and the other two methods. There is no A260 data for 
two samples (13 and 17), and all female samples were excluded from 
the comparisons to the Quantifiler Y kit results.

Table 6-10 Comparison with A260 and Quantiblot kit

Sample Sex
A260 

Result 
(ng/µL)

QBa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

1 M 17.5 20 6.69 61.7 66.6 10.13 41.9 49.4

2 M 15.4 20 14.3 7.1 28.5 16.78 9.0 16.1

3 M 13.9 30 15.48 11.4 48.4 14.30 2.9 52.3

4 M 11.4 20 12.44 9.6 37.8 12.45 9.7 37.8

5 M 10.3 20 12.69 23.2 36.6 11.00 6.8 45.0

6 M 13.9 20 12.54 9.8 37.3 13.56 2.4 32.2

7 M 11.5 40 13.78 20.1 65.6 12.28 7.1 69.3
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8 M 11.2 20 13.51 21.2 32.5 11.77 5.6 41.2

9 M 9.8 20 15.09 54.0 24.6 13.06 33.3 34.7

10 M 9.7 20 13.98 44.1 30.1 12.29 26.7 38.6

11 M 13.0 20 11.27 13.3 43.7 12.85 1.2 35.8

12 M 13.3 30 9.92 25.1 66.9 11.59 12.5 61.4

13 M nd 14 13.90 n.d. 0.7 11.31 n.d. 19.2

14 F 12.8 16 13.90 9.0 13.1 neg n.d. n.d.

15 M 15.7 16 12.62 19.4 21.1 13.89 11.2 13.2

16 M 12.1 24 13.09 8.2 45.5 10.78 10.9 55.1

17 M nd 20 12.81 n.d. 36.0 14.36 n.d. 28.2

18 M 13.5 24 8.18 39.4 65.9 10.25 24.1 57.3

19 M 13.2 20 10.37 21.4 48.2 13.12 0.6 34.4

20 M 12.9 16 12.69 1.2 20.7 12.36 3.8 22.8

21 M 11.0 14 13.48 22.9 3.7 13.00 18.5 7.1

22 M 11.5 24 12.23 6.6 49.0 12.85 12.0 46.5

23 M 10.9 14 10.91 0.6 22.1 11.73 8.1 16.2

24 M 12.4 20 15.19 22.8 24.1 14.38 16.2 28.1

25 M 10.8 20 15.21 41.5 24.0 18.07 68.1 9.7

26 F 13.9 20 14.00 1.1 30.0 −b n.d. n.d.

27 F 11.5 32 13.16 14.4 58.9 − n.d. n.d.

28 F 11.5 40 10.51 8.6 73.7 − n.d. n.d.

Table 6-10 Comparison with A260 and Quantiblot kit (continued)

Sample Sex
A260 

Result 
(ng/µL)

QBa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB
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29 F 11.2 20 10.45 6.3 47.8 − n.d. n.d.

30 F 16.0 20 12.56 21.5 37.2 − n.d. n.d.

31 F 10.9 20 12.12 11.7 39.4 − n.d. n.d.

32 F 10.9 40 9.42 13.6 76.5 − n.d. n.d.

33 F 11.5 20 13.95 21.3 30.3 − n.d. n.d.

34 F 10.4 20 12.14 16.7 39.3 − n.d. n.d.

35 F 11.1 40 12.38 11.3 69.1 − n.d. n.d.

36 F 10.5 20 13.38 28.0 33.1 − n.d. n.d.

37 F 12.0 24 12.50 4.2 47.9 − n.d. n.d.

38 F 10.8 20 9.59 11.0 52.1 − n.d. n.d.

39 F 11.4 16 10.42 8.8 34.9 − n.d. n.d.

40 F 10.4 40 11.16 7.3 72.1 − n.d. n.d.

41 F 12.6 20 12.49 0.9 37.6 − n.d. n.d.

42 F 12.5 28 8.68 30.3 69.0 − n.d. n.d.

43 F 12.2 20 13.57 11.5 32.2 − n.d. n.d.

44 F 9.8 16 9.42 3.9 41.1 − n.d. n.d.

45 F 12.4 16 10.96 11.6 31.5 − n.d. n.d.

46 F 12.2 16 11.49 5.4 28.2 − n.d. n.d.

47 F 10.4 40 12.93 24.1 67.7 − n.d. n.d.

48 F 12.3 20 12.23 0.6 38.9 − n.d. n.d.

Table 6-10 Comparison with A260 and Quantiblot kit (continued)

Sample Sex
A260 

Result 
(ng/µL)

QBa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB
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The different methods produced similar quantification results.

6.1.12  Comparison with A260 and Dye Intercalation

The concentration of DNA was measured for 13 human genomic 
DNA samples using the A260 method, a dye intercalation method, and 
the Quantifiler kits.

DNA Samples
Tested

Six human genomic DNA samples were obtained from different 
commercial sources.

49 F 10.7 40 15.02 40.4 62.5 − n.d. n.d.

50 F 12.8 32 13.50 5.5 57.8 − n.d. n.d.

a. Quantiblot kit method
b. Negative (−) result

Table 6-10 Comparison with A260 and Quantiblot kit (continued)

Sample Sex
A260 

Result 
(ng/µL)

QBa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from 
QB

Table 6-11 Average differences from A260 and Quantiblot kit

Method
Average Difference (%)

Quantifiler Human Kit Quantifiler Y Kit

A260 16.9 15.1

Quantiblot 42.0 35.5

Table 6-12 Human DNA samples tested with A260 and dye 
intercalation

DNA Sex Extraction Source

007 Male Blood

9948 Male Cell line
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Experiment Using the concentrations provided by the supplier, the DNA samples 
were diluted to 2.0 ng/µL (A), 0.5 ng/µL (B), and 0.1 ng/µL (C).

Note: All dilutions were made in T10E0.1 Buffer with 20 µg/mL 
glycogen added as a carrier and stabilizer.

All sample dilutions were quantified using the following methods:

• A260 – Because the concentrations of the dilutions extended 
below the detection limit of the spectrophotometer, ultraviolet 
absorbance at 260 nm was measured for only the highest 
dilution (2.0 ng/µL).
DNA concentration was calculated from the formula:

Concentration (µg/mL) = 50 × A260

The results calculated for the 2.0 ng/µL dilutions were then 
extrapolated for the other dilutions (0.5 ng/µL and 0.1 ng/µL), 
using the known dilution factors.

• Dye intercalation – The microplate assay mode was used and 
the plate was read on an ABI PRISM® 7700 Sequence Detection 
System (7700 SDS). All of the sample dilutions were within the 
detection range of the assay. The assay was run using the 
λ bacteriophage DNA quantification standard supplied with the 
kit and a quantification standard based on Raji human genomic 
DNA. There were significant differences between the standard 
curves from the λ DNA and Raji DNA. The results obtained 
from using the Raji DNA standard were used in this experiment 
because the Raji DNA was considered to be more similar to the 
DNA measured in these experiments and because the results 
from using the Raji DNA standard were closer to the results 
obtained by the other methods.

Human genomic Male Blood

Raji-1 Male Cell line

Raji-2 Male Cell line

K-562 Female Cell line

Table 6-12 Human DNA samples tested with A260 and dye 
intercalation

DNA Sex Extraction Source
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• Quantifiler kits – DNA was quantified using the standard 
procedure. The Quantifiler® Human DNA standard provided 
with the kits was used as recommended, with duplicate reactions 
for each of eight serial dilutions.

For each sample, the percent differences between Quantifiler kit 
results and results from the other two methods were calculated. The 
differences were expressed as a percentage of the reference method. 
For each method, the average percent differences from Quantifiler kit 
results were calculated. For comparisons with the Quantifiler Y kit, 
only results from male samples were used.

Results Table 6-13 shows the DNA concentrations calculated for all samples 
using the A260 method, the dye intercalation method, Quantifiler 
Human kit, and Quantifiler Y kit. It also shows the percent 
differences calculated for the comparisons between the Quantifiler 
Human kit or the Quantifiler Y kit and the A260 method and the dye 
intercalation method.
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Table 6-13 Comparison with A260 and dye intercalation

Sample
A260 

Result 
(ng/µL)

DIa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from

DI

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from

DI

007 A 2.74 2.502 2.580 5.8 3.1 3.760 37.2 50.3

007 B 0.685 0.756 0.894 30.5 18.3 1.180 72.3 56.2

007 C 0.137 0.176 0.216 57.7 22.6 0.238 73.7 35.1

9948 A 1.9 2.286 2.300 21.1 0.6 2.590 36.3 13.3

9948 B 0.475 0.496 0.504 6.1 1.5 0.810 70.5 63.2

9948 C 0.095 0.103 0.123 29.5 19.4 0.146 53.7 41.7

Human 
genomic A

2.2 2.270 1.810 17.7 20.3 2.010 8.6 11.5

Human 
genomic B

0.55 0.584 0.495 10.0 15.2 0.577 4.9 1.1

Human 
genomic C

0.11 0.134 0.128 16.4 4.8 0.081 26.2 39.6

Raji-1 A 2 1.271 1.920 4.0 51.0 2.500 25.0 96.7

Raji-1 B 0.5 0.351 0.484 3.2 38.1 0.679 35.8 93.7

Raji-1 C 0.1 0.085 0.149 49.0 76.1 0.123 23.0 45.4

Raji-2 A 1.98 1.262 1.720 13.1 36.3 2.630 32.8 108.4

Raji-2 B 0.495 0.357 0.419 15.4 17.3 0.574 16.0 60.7

Raji-2 C 0.099 0.110 0.113 14.1 2.5 0.091 7.7 17.1

K-562 A 2.76 1.317 1.360 50.7 3.3 neg  n.d.  n.d.

K-562 B 0.69 0.365 0.379 45.1 3.9 neg  n.d.  n.d.

K-562 C 0.138 0.104 0.096 30.4 7.9 neg  n.d.  n.d.

a. Dye intercalation method
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The different methods produced similar quantification results.

6.1.13  Assay Background

An experiment was performed to check the assay system for false-
positive results that would indicate the presence of human DNA in a 
sample that contained none.

Experiment For each Quantifiler kit, 48 negative control reactions were set up. 
PCR Mixes were prepared and dispensed into wells of the reaction 
plate according to the standard procedure. For each negative control 
reaction, 2 µL of T10E0.1 Buffer was added. All standard assay 
parameters were used, except that the number of thermal cycles was 
extended from 40 to 50 for increased stringency.

Results Figures 6-14 and 6-15 show that all 48 reactions with each assay were 
negative for their respective human DNA targets. The IPC reactions 
amplified for all reactions in both assays, indicating that the assay 
systems performed normally. These data show that there is no 
inherent false-positive background associated with the Quantifiler 
kits. However, the assays are extremely sensitive, and achieving clean 
results requires care in assay setup and good contamination control 
for reagents, instruments, and laboratory work surfaces.

Table 6-14 Average differences from A260 and dye intercalation 

Method
Average Difference (%)

Quantifiler Human Kit Quantifiler Y Kit

A260 23.3 34.9

Dye intercalation 19.0 48.0
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Figure 6-14 Assay background with the Quantifiler Human kit

Figure 6-15 Assay background with the Quantifiler Y kit

IPC amplification

Human DNA 
amplification

IPC amplification

Human Y DNA 
amplification
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Section 6.2 Applied Biosystems 
7900HT Real-Time PCR System 
Validation (SDS Software v2.0)

Overview Certain performance parameters for the Quantifiler kits were also 
tested separately using the ABI PRISM® 7900HT Sequence Detection 
System (7900HT SDS). The experiments performed for the 7900HT 
SDS were less exhaustive than those for the 7000 instrument (see 
previous section) and were performed to test and compare the most 
sensitive parameters of assay performance between the two 
instrument platforms.

Experiments 6.2.1 Precision (7900HT SDS) . . . . . . . . . . . . . . . . . . . . . . . . . . .6-37
6.2.2 Mixture Studies (7900HT SDS)  . . . . . . . . . . . . . . . . . . . . .6-40
6.2.3 Comparisons with Other Methods (7900HT SDS) . . . . . . .6-42

6.2.1  Precision (7900HT SDS)

Experiment One set of eight serial dilutions of the Quantifiler Human DNA 
Standard was prepared. The dilutions ranged from 50 ng/µL to 
23 pg/µL in three-fold increments.

Three identical runs containing both Quantifiler Human and 
Quantifiler Y kits were performed, each containing duplicate 
reactions of the dilutions for each assay. The three runs were 
performed on different days on the same 7900HT SDS instrument, all 
using standard thermal cycler conditions for the Quantifiler kits.

The CT FAM values were recorded and the means and standard 
deviations of the CT FAM values were calculated for each of the eight 
dilutions using the Quantifiler Human kit and the Quantifiler Y kit.
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Results Table 6-15 shows the means and standard deviations of the CT FAM 
values calculated for all reactions of each quantification standard 
dilution for the Quantifiler Human kit and the Quantifiler Y kit.

Table 6-15 Means and standard deviations for CT results

 DNA 
Quantity 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit 

CT (Mean) Standard 
Deviation CT (Mean) Standard 

Deviation

50 23.83 0.13 24.50 0.09

16.7 25.36 0.08 26.08 0.09

5.56 26.79 0.08 27.50 0.06

1.85 28.14 0.08 29.03 0.08

0.62 29.56 0.14 30.68 0.30

0.21 31.00 0.06 32.54 0.42

0.068 32.51 0.25 34.41 0.56

0.023 33.86 0.49 35.59 0.58
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The following results are consistent with the 7000 SDS results:

• CT vs. sample concentration
• Standard deviations of the CT values
• CT value calculated using the Quantifiler Human kit was lower 

than that for the Quantifiler Y kit because there is only one copy 
of the Y chromosome target locus and two copies of the 
autosomal human target locus.

The CT results for all quantification standard dilutions reactions 
using the Quantifiler Human kit and the Quantifiler Y kit are 
displayed in Figures 6-16 and 6-17. For each of the dilutions, the 
mean and the standard deviation of CT FAM for the repeated runs is 
shown.

Figure 6-16 Precision: Quantifiler Human kit CT results 
(7900HT SDS)
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Figure 6-17 Precision: Quantifiler Y kit CT results (7900HT SDS)

6.2.2  Mixture Studies (7900HT SDS)

An experiment was performed to demonstrate the specificity of the 
Quantifiler Human kit and the Quantifiler Y kit in analyzing 
mixtures of human genomic DNA from male and female sources. 
The mixture studies were designed to simulate circumstances in 
which a small component of male DNA must be discerned from a 
high background of female DNA.

Experiment Purified genomic DNA from the Raji (male) and K-562 (female) cell 
lines were combined in ratios of 1:1, 1:4, 1:16, 1:64, 1:256 and 
1:1024 (Raji:K-562). The male DNA was added at a constant level of 
0.05 ng/µL in all samples, and the female DNA was present at 
amounts ranging from 0.05 ng/µL in the 1:1 sample to 50 ng/µL in 
the 1:1024 sample. The DNA amounts were based on the DNA 
concentrations provided by the suppliers and were not calibrated with 
the Quantifiler kits.

The mixtures were tested with the Quantifiler Human kit assay and 
the Quantifiler Y kit assay to determine the concentrations of total 
human genomic DNA (Quantifiler Human kit) and male DNA only 
(Quantifiler Y kit). For each sample, three replicate reactions were 
performed for each assay. Each assay used the same set of 8 human 
genomic DNA quantification standards run in duplicate reactions for 
each assay and both assays were run on the same reaction plate. The 
reaction plates were run on a 7900HT instrument.
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Results The quantification results from using the Quantifiler Human kit 
varied from an average of 0.12 ng/µL for the 1:1 sample to 60 ng/µL 
for the 1:1024 sample, consistent with the increasing amounts of 
female DNA present.

The quantification results from using the Quantifiler Y kit varied 
from between 0.023 ng/µL to 0.058 ng/µL for all samples, regardless 
of the amount of female DNA present.

For the 1:1024 sample, the results showed a ratio of male DNA to 
total DNA of 1:1700. Differences between target concentrations and 
actual measurements were expected because the amounts of DNA 
added to the mixtures were based on the DNA concentrations 
provided by the suppliers and were not calibrated with the Quantifiler 
kits.

The results showed that the male DNA was detected and quantified 
accurately in all samples, regardless of the amount of female DNA 
present.

Quantifiler Y kit
Quantifiler Human kit
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6.2.3  Comparisons with Other Methods (7900HT SDS)

Experiment Six human genomic DNA samples were obtained from different 
commercial sources.

Using the concentrations provided by the supplier, the DNA samples 
were diluted to 2.0 ng/µL (A), 0.5 ng/µL (B), and 0.1 ng/µL (C).

Note: All dilutions were made in T10E0.1 Buffer with 20 µg/mL 
glycogen added as a carrier and stabilizer.

All sample dilutions were quantified using the following methods:

• A260 – Because the concentrations of the dilutions extended 
below the detection limit of the spectrophotometer, absorbance 
at 260 nm was measured only for the highest dilution 
(2.0 ng/µL).
DNA concentration was calculated from the formula:

Concentration (µg/mL) = 50 × A260

The results calculated for the 2.0 ng/µL dilutions were then 
extrapolated for the higher dilutions (0.5 ng/µL and 0.1 ng/µL) 
using the known dilution factors.

• Dye intercalation – The microplate assay mode was used and 
the plate was read on a 7700 SDS. All of the sample dilutions 
were within the detection range of the assay. The assay was run 
using the λ bacteriophage DNA quantification standard supplied 
with the kit and a quantification standard based on Raji human 
genomic DNA. There were significant differences between the 

Table 6-16 DNA samples tested with A260 and dye intercalation 
(7900HT SDS)

DNA Sex Extraction Source

007 Male Blood

9948 Male Cell line

Human genomic Male Blood

Raji-1 Male Cell line

Raji-2 Male Cell line

K-562 Female Cell line
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standard curves from the λ DNA and Raji DNA. The results 
obtained from using the Raji DNA standard were used in these 
experiments because the Raji DNA was considered to be more 
similar to the DNA measured and because the results from using 
the Raji DNA standard were closer to the results obtained by the 
other methods.

• Quantifiler kits – DNA was quantified using the standard 
procedure. The Quantifiler Human DNA standard provided with 
the kits was used as recommended, with duplicate reactions for 
each of eight serial dilutions.

For each sample, the percent differences between Quantifiler kit 
results and results from the other two methods were calculated. The 
differences were expressed as a percentage of the reference method. 
For each method, the average percent differences from Quantifiler kit 
results were calculated. For comparisons with the Quantifiler Y kit, 
only results from male samples were used.

Results Table 6-17 shows the DNA concentrations calculated for all samples 
using the A260 method, the dye intercalation method, the Quantifiler 
Human kit, and the Quantifiler Y kit. It also shows the percent 
differences calculated for the comparisons.

Table 6-17 Comparison with A260 and dye intercalation (7900HT SDS)

Sample
A260 

Result 
(ng/µL)

DIa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from DI

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from DI

007 A 2.74 2.502 2.094 23.6 16.3 3.547 29.4 41.8

007 B 0.685 0.756 1.007 47.0 33.2 0.950 38.6 25.7

007 C 0.137 0.176 0.272 98.8 54.6 0.220 60.3 24.6

9948 A 1.9 2.286 2.215 16.6 3.1 2.562 34.8 12.1

9948 B 0.475 0.496 0.677 42.5 36.4 0.634 33.5 27.8

9948 C 0.095 0.103 0.144 51.1 39.3 0.115 21.1 11.6

Human 
genomic A

2.2 2.270 2.887 31.2 27.2 1.792 18.6 21.1
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Human 
genomic B

0.55 0.584 0.805 46.3 37.9 0.379 31.0 35.0

Human 
genomic C

0.11 0.134 0.184 67.4 36.9 0.105 4.3 21.7

K-562 A 2.76 1.317 1.631 40.9 23.9 0.000 n.d. n.d.

K-562 B 0.69 0.365 0.474 31.4 29.9 0.000 n.d. n.d.

K-562 C 0.138 0.104 0.060 56.2 42.1 0.000 n.d. n.d.

Raji-1 A 2 1.271 1.702 14.9 33.9 2.101 5.0 65.2

Raji-1 B 0.5 0.351 0.483 3.4 37.7 0.547 9.5 56.1

Raji-1 C 0.1 0.085 0.094 6.4 10.6 0.109 8.5 28.3

Raji-2 A 1.98 1.262 1.555 21.5 23.2 2.134 7.8 69.1

Raji-2 B 0.495 0.357 0.446 9.9 24.9 0.606 22.4 69.7

Raji-2 C 0.099 0.110 0.081 17.7 26.1 0.126 27.0 14.0

a. Dye intercalation method

Table 6-17 Comparison with A260 and dye intercalation (7900HT SDS)

Sample
A260 

Result 
(ng/µL)

DIa 
Result 
(ng/µL)

Quantifiler Human Kit Quantifiler Y Kit

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from DI

Result 
(ng/µL)

% Diff. 
from 
A260

% Diff. 
from DI
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The different methods produced similar quantification results.

Table 6-18 Average differences from A260 and dye intercalation 
(7900HT)

Method
Average Difference (%)

Quantifiler Human Kit Quantifiler Y Kit

A260 34.8 23.5

Dye intercalation 29.8 34.9
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Section 6.3 Casework Sample Analysis

Case Type
Studies

There is a recommended optimal DNA concentration range for using 
AmpFlSTR® PCR Amplification kits. The recommended amount of 
DNA input for the AmpFlSTR® Identifiler® PCR Amplification Kit 
is 0.5 to 1.25 ng human DNA (total per reaction), and for four-dye 
assays such as the AmpFlSTR® Profiler Plus® PCR Amplification 
Kit, 1.0 to 2.5 ng.

DNA quantification is specified as a requirement by the Scientific 
Working Group on DNA Analysis Methods (SWGDAM) as a 
preliminary step to STR genotyping (Scientific Working Group on 
DNA Analysis Methods, 2000).

Experiment A set of samples consisting of both non-casework and casework 
samples was tested. Of the sample set, 6 samples were non-casework, 
consisting primarily of blood sample extracts from single sources, 
and 22 were casework DNA extracts from fabric, clothing, or surface 
swabs. All DNA samples were prepared by organic extraction.

The DNA samples were quantified using the QuantiBlot® Human 
DNA Quantitation Kit (Applied Biosystems) and the Quantifiler 
Human kit performed on both the 7000 SDS and 7900HT SDS. The 
QuantiBlot kit was used in the chemiluminescent autoradiography 
mode. Tests with the Quantifiler kits for the 7000 SDS and 7900HT 
SDS were performed according to the standard procedure.

Using the results from the Quantifiler Human kit and the 7000 SDS, 
between 0.8 and 1.4 ng human genomic DNA was added to each 
Identifiler kit reaction, with many of the samples added at 
approximately 1.0 ng per reaction. Identifiler kit reactions were 
processed on the ABI PRISM® 3100 Genetic Analyzer and analyzed 
using GeneScan® Software v3.7.1 and Genotyper® Software v3.7, for 
use with the Windows NT® operating system. The STR profiles 
obtained from using the Identifiler kit were analyzed. Successful 
STR profiles produced complete profiles with peak heights between 
200 and 4000 relative fluorescence units (RFU).



Section 6.3 Casework Sample Analysis

Quantifiler Kits User’s Manual 6-47

Results According to the results from the Quantifiler Human kit reactions run 
on the 7000 SDS, the range of DNA concentrations was 0.06 ng/µL 
to 2.61 ng/µL (Table 6-19).

Successful STR profiles were obtained for the 28 samples that were 
analyzed (Figure 6-18). These samples contained the minimum 
amount of DNA recommended for optimal Identifiler kit results 
(50 pg/µL in a 10-µL reaction). For some samples in the original set, 
the volume of DNA sample remaining after DNA quantification was 
insufficient to perform STR assays; these samples were not included 
in the data presented.

Table 6-19 Input for STR analysis of casework samples

STRa Sample

Quantity (ng/µL)
Input Amount 
for Identifiler 

Kit (ng)QuantiBlot Kit
Quantifiler 
Human Kit 

and 7000 SDS

Quantifiler 
Human Kit and 

7900HT SDS

Non-casework 0.4 0.42 0.4 1.0

Non-casework 0.4 0.50 0.50 1.2

Non-casework 0.4 0.23 0.38 1.3

Non-casework 0.4 0.54 0.56 1.3

Non-casework 0.16 0.17 0.23 1.0

Non-casework 0.4 0.67 0.65 1.4

Positive control n.d. n.d. n.d. 1.0

Negative control n.d. n.d. n.d. 0.0

Cutting from shirt 0.4 0.78 0.88 1.1

Cutting from shirt 0.4 0.66 0.99 1.1

Cutting from fabric 0.06 0.093 0.11 1.2

Cutting from fabric 0.06 0.060 0.087 0.8

1

2

3

4

5

6

7

8

9

10

11

12
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Cutting from denim 0.16 0.10 0.13 1.3

Cutting from sock 0.04 0.11 0.15 1.1

Cutting from 
sweatshirt

1.2 2.61 3.75 1.4

Cutting from cotton 0.4 0.52 0.87 1.1

Cutting from 
sweatshirt

0.4 0.94 0.97 1.0

Cutting from cloth 0.4 0.31 0.56 1.1

Cutting from fabric 0.04 0.23 0.34 1.1

Cutting from leather 0.08 0.10 0.18 1.2

Cutting from carpet 0.4 0.76 0.95 1.3

Cutting from cloth 1.6 1.89 2.95 1.1

Cutting from shirt 1.2 2.29 3.10 1.2

Swab from hammer 0.6 0.47 0.58 1.1

Cutting from cloth 0.4 0.45 0.58 1.1

Cutting from fabric 0.08 0.16 0.18 1.3

Cutting from carpet 0.4 1.45 1.62 1.3

Cutting from cap 0.4 0.45 0.46 1.0

Cutting from shirt 1.2 2.29 3.10 1.3

a. See Figure 6-18 for STR profiles.

Table 6-19 Input for STR analysis of casework samples (continued)

STRa Sample

Quantity (ng/µL)
Input Amount 
for Identifiler 

Kit (ng)QuantiBlot Kit
Quantifiler 
Human Kit 

and 7000 SDS

Quantifiler 
Human Kit and 

7900HT SDS
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Figure 6-18 STR profiles of casework samples
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Section 6.4 Applied Biosystems 
7500 Real-Time PCR System 
Validation (SDS Software v1.2.3)

Overview The Quantifiler® Human DNA Quantification Kit and the 
Quantifiler® Y Human Male DNA Quantification Kit were tested 
(see the experiments listed below) using the Applied Biosystems 
7500 Real-Time PCR System with SDS Software v1.2.3, running on 
the Windows® XP operating system. The results were then compared 
to the previously validated ABI PRISM® 7000 Sequence Detection 
System with SDS Software v1.0.

The experimental data generated demonstrate that the 7500 System 
(SDS Software v1.2.3):

• Provides accurate results when used with the Quantifiler kits for 
the analysis of genomic DNA samples.

• Produced results that are statistically similar to the results 
produced on the previously validated 7000 System (SDS 
Software v1.0).

Validation
Experiments

Performed

• Precision and Accuracy
• Reproducibility and Sensitivity
• Background
• Auto Baseline versus Manual analysis

6.4.1  Materials and Methods

6.4.1.1  Reagents

To minimize variables from hand pipetting and lot-to-lot reagent 
differences, the following set up procedures were used throughout the 
study:

• Eight serial dilutions were made with one lot of standard DNA 
provided with the Quantifiler kits (first dilution prepared with 
500 µL DNA and 1,000 µL 10 mM Tris-HCl (pH 8.0) and 0.1 
mM Na2EDTA (T10E0.1 buffer)).
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• One manufactured lot of each kit was used for all validation 
studies:

6.4.1.2  Instruments

Three 7500 systems (SDS Software v1.2.3) and three 7000 systems 
(SDS Software v1.0) were used for this study (six instruments total). 
Before the study, each instrument was calibrated by an Applied 
Biosystems service engineer (ROI calibration, background 
calibration, optical calibration, pure dye calibration, RNase P run). 

The Biomek® FX Laboratory Automation Workstation was used to 
set up the real-time PCR reaction plates to minimize hand-pipetting 
variations: 

• The PCR master mixes (PCR reagents with standard or sample 
DNA mixed together) were aliquoted into a 96-well plate 
(PCR master mix plate). 

• Six empty 96-well plates and the PCR master mix plate were 
placed on the Biomek FX work surface.

• The Biomek FX aspirated 25 µL from the PCR master mix 
plate, then slowly dispensed it into the corresponding well in an 
empty 96-well plate. The plates were sealed, spun down, then 
quickly loaded onto a 7500 or 7000 system. This process 
ensured timely and precise replication of real-time PCR plates 
for six instruments at a time.

6.4.2  Experimental Setup

Precision and
Accuracy Testing

On each 96-well reaction plate, six sets of standard dilutions for each 
Quantifiler kit were set up for real-time PCR. Figure 6-19 shows the 
experimental plate layout.

For each instrument, six replicate plates were run consecutively. The 
cycle threshold (CT), R2, and slope values were compared statistically 
to determine precision and accuracy, which established 95% 
confidence intervals for each instrument type. 

Kit Part Number Lot Number

Quantifiler Human Kit 4343895 0501020

Quantifiler Y Human Male Kit 4343906 0501018
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Figure 6-19 Plate layout – Precision and accuracy testing on the 
7500 System (SDS Software v1.2.3) and 7000 System (SDS 
Software v1.0)

7500 Systems (3) 7000 Systems (3)

Quantifiler® 
Human DNA 

Quantification Kit

Quantifiler® Y Human 
Male DNA 

Quantification Kit
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Reproducibility
and Sensitivity

Testing

On each 96-well reaction plate, the following were set up for 
real-time PCR:

• Standard dilution series (two replicates of each dilution point)
• Five replicate serial dilution sets of two sample DNAs (Raji and 

9948B)

The experimental plate layout is shown in Figure 6-20.

Figure 6-20 Plate Layout – Reproducibility and sensitivity testing 
on the 7500 System (identical plate layout for both kits) 

On each instrument, six replicate plates were run consecutively with 
each Quantifiler kit (for a total of 18 plates on 7500 systems and 
18 plates on 7000 systems). 

To demonstrate reproducibility and sensitivity, the replicate DNA 
samples were quantitated, and the results were compared statistically 
between instrument types.

7000 Systems (3)7500 Systems (3)

Standard 
curve

DNA 1 DNA 2

Quantifiler Human 
Kit or Quantifiler Y 
Human Male Kit

Standard
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Background
Testing

Ninety-five no template controls (NTCs) and one positive control 
(the 50 ng/µL standard DNA dilution sample) were set up on a 
96-well plate. One plate from each Quantifiler kit was run on each 
instrument (for a total of 12 plates).

6.4.3  Data Collection

The standard thermal cycling protocol (9600 Emulation mode) 
described in the Chapter 3, “PCR Amplification,” was used for all 
instrument runs.

6.4.4  Data Analysis

Initial Data
Compiling and

Analysis

All runs were analyzed initially using Manual analysis mode, with the 
baseline set to 3 to 15 and the threshold set at 0.2.

Average values and standard deviations for CT, slope, and R2 were 
calculated for all replicate samples in a run. 

For Auto-Baseline-to-Manual analysis comparisons, the run files 
from the 7500 System (SDS Software v1.2.3) were reanalyzed using 
Auto Baseline mode and a threshold of 0.2.

Statistical Data
Analysis

For statistical analysis, the Stat-Ease Design-Expert® Software was 
used for all ANOVA (analysis of variance) calculations. For paired 
t-Tests analysis, MicroSoft® Excel Analysis ToolPak software was 
used.

6.4.4.1  Precision and Accuracy

For the precision and accuracy tests between the two instrument 
types, the following values were determined:

• Average CT

• Average Slope 
• Average R2

• 95% confidence intervals (CI) by ANOVA analysis
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CT Results Table 6-20 shows the average CT values (95% CI) for the 7500 
System (SDS Software v1.2.3) and the 7000 System (SDS Software 
v1.0) at each standard curve dilution.

Statistically, the two instrument types resulted in significantly 
different CT values (p <0.0001) when compared with the ANOVA 
analysis. No significant difference in CT values was observed when 
comparing results from instruments of the same type.

Table 6-20 CT Values (95% CI)

Standard 
Curve 

Dilution 
(ng/µL)

7500 System 7000 System

Average 
CT Value 
(95% CI)

CT Value Range (95% CI)
Average 
CT Value 
(95% CI)

CT Value Range (95% CI)

50 23.29 23.21 to 23.37 23.05 22.97 to 23.13

16.7 24.98 24.90 to 25.06 24.56 24.48 to 24.64

5.56 26.53 26.44 to 26.61 26.08 26.00 to 26.16

1.85 28.05 27.97 to 28.14 27.53 27.45 to 27.61

0.62 29.44 29.36 to 29.53 29.00 28.92 to 29.09

0.21 30.86 30.78 to 30.94 30.33 30.25 to 30.41

0.068 32.40 32.32 to 32.48 31.61 31.53 to 31.70

0.023 33.98 33.88 to 34.05 33.03 32.95 to 33.11
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Slope Results Figure 6-21 shows the average slope values obtained for replicate 
standard curves run on each instrument. The slope values obtained 
for the 7500 System (SDS Software v1.2.3) are listed below and are 
within the ranges previously established on the 7000 System (SDS 
Software v1.0):

Figure 6-21 Average slope values – Replicate standard curves

Kit Slope Established Slope 
Range

Quantifiler Human Kit −2.93 to −3.18 −2.9 to −3.3

Quantifiler Y Human Male Kit −3.05 to −3.36 −3.0 to −3.6

Average Slope per Instrument
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R2 Results Figure 6-22 shows the average R2 values obtained for replicate 
standard curves on each instrument. All R2 values were greater than 
0.98 and are within the established range.

Figure 6-22 Average R2 values – Replicate standard curves

6.4.4.2  Reproducibility and Sensitivity 

Two sample DNAs were quantitated for this experiment. Eight 3-fold 
serial dilutions for each sample were run (five replicates per dilution, 
40 wells per sample). The CT values were generated in Manual 
analysis mode, then the quantities were calculated using the standard 
curve on each plate.

Figure 6-23 shows average CT values (each point n = 90 replicates) 
across a set of four serial dilutions (2 ng/µL to 0.5 ng/µL) with the 
Quantifiler Human Kit and the corresponding quantitated 
concentrations for one DNA sample. Similar results were obtained 
for the second DNA sample and the Quantifiler Y Human Male Kit 
(data not shown).

As the data show, differences in CT values do not affect calculated 
quantities (calculated quantities were normalized resulting in 
comparable concentrations on both instrument types).
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Figure 6-23 CT values and quantitated concentrations – 
Quantifiler Human Kit (comparable data were obtained for the 
Quantifiler Y Human Male Kit)
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Table 6-21 shows the average calculated quantities for each DNA 
sample obtained with the Quantifiler Human Kit. For sample 
concentrations between 2 ng/µL and 0.5 ng/µL, the percent 
difference between the quantitated values between instrument types 
did not exceed 16%. No statistically significant difference was 
observed for calculated quantities obtained using the Quantifiler 
Human Kit on the two instrument types. 

Table 6-21 Average Calculated DNA Quantities – Quantifiler Human Kit

DNA 
Sample

7000 Avg 
Calculated 
Qty. (ng/µL)

7000 
Std. 
Dev.

7500 Avg 
Calculated 

Qty. 
(ng/µL)

7500 
Std. 
Dev.

Difference 
Between 7000 & 
7500 Calculated 

Qty. (ng/µL)

% Difference 
of 7000 Qty. 
Value from 

7500 Qty. Value

Raji 9.33 0.51 9.14 0.33 0.19 2.04

4.58 0.15 4.24 0.12 0.34 7.72

2.30 0.11 2.09 0.04 0.21 9.63

1.16 0.05 1.07 0.03 0.09 8.01

0.59 0.03 0.55 0.01 0.04 6.91

0.27 0.01 0.26 0.01 0.01 3.43

0.15 0.01 0.15 0.01 0.00 3.24

0.08 0.00 0.07 0.00 0.01 8.04

9948 4.65 0.15 5.02 0.20 −0.37 7.58

2.33 0.02 2.34 0.05 −0.01 0.36

1.16 0.05 1.09 0.03 0.07 5.98

0.59 0.02 0.50 0.03 0.08 15.52

0.31 0.02 0.27 0.01 0.04 12.31

0.17 0.01 0.15 0.01 0.02 10.80

0.08 0.01 0.06 0.00 0.03 38.59

0.05 0.01 0.04 0.00 0.01 18.14
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Table 6-22 shows the average calculated quantities for each DNA 
sample obtained with the Quantifiler Y Human Male Kit. For sample 
concentrations of 2 ng/µL to 0.5 ng/µL, the percent difference 
between the quantitated values between instrument types did not 
exceed 18%. A minimal statistical difference was observed for 
calculated quantities obtained using the Quantifiler Y Human Male 
Kit on the two instrument types (p = 0.0027). 

Table 6-22 Average Calculated DNA Quantities – Quantifiler Y Human Male Kit

DNA 
Sample

7000 Ave. 
Calculated 
Qty. (ng/µL)

7000 
Std. 
Dev.

7500 Ave. 
Calculated 
Qty. (ng/µL)

7500 Std. 
Dev. 

Difference 
Between 

7000 & 7500 
Calculated 
Qty. (ng/µL)

% Difference 
of 7000 Qty. 
Value from 
7500 Qty. 

Value

Raji 9.12 0.40 9.09 0.07 0.03 0.34

4.60 0.20 4.66 0.04 −0.06 1.29

2.53 0.07 2.36 0.05 0.17 7.04

1.29 0.09 1.19 0.03 0.10 8.12

0.66 0.05 0.62 0.03 0.05 7.36

0.33 0.02 0.30 0.02 0.02 7.89

0.15 0.02 0.14 0.01 0.02 11.55

0.070 0.02 0.057 0.01 0.01 19.85

9948 4.71 0.12 4.56 0.06 0.15 3.19

2.43 0.14 2.30 0.06 0.12 5.14

1.34 0.09 1.13 0.05 0.21 17.34

0.68 0.03 0.62 0.03 0.06 9.93

0.33 0.03 0.28 0.03 0.05 15.60

0.18 0.01 0.14 0.01 0.04 24.87

0.08 0.00 0.05 0.00 0.02 34.65

0.04 0.00 0.03 0.00 0.01 38.29
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6.4.4.3  Background 

Figure 6-24 shows background amplification plots for 95 NTCs and 
one positive control for both kits (one plate each) run on the 7000 
System (SDS Software v1.0). Figure 6-25 shows background 
amplification plots for the 7500 System (SDS Software v1.2.3). 

On all instruments, the 95 NTC samples yielded negative results 
(all CT values >40) with both Quantifiler kits.

Figure 6-24 Background amplification plots – 7000 System (SDS 
Software v1.0)

Figure 6-25 Background amplification plots – 7500 System (SDS 
Software v1.2.3)

Quantifiler Human Kit Quantifiler Y Human Male Kit

Quantifiler Human Kit Quantifiler Y Human Male Kit
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6.4.4.4  Auto Baseline Analysis Versus Manual Analysis

CT Precision and
Accuracy

For Auto-Baseline-to-Manual analysis comparisons:

• The SDS software v1.2.3 data from the experiments described 
on the previous pages were reanalyzed in Auto Baseline mode 
(default threshold 0.2).

• The CT values were compared to each other.

Figure 6-26 shows the CT values obtained using the Auto Baseline 
and Manual analysis modes with the Quantifiler Human Kit. Similar 
data were obtained for the Quantifiler Y Human Male Kit.

No statistically significant differences were observed for CT values 
generated using the Auto Baseline and Manual analysis modes with 
either Quantifiler kit.   

Figure 6-26 Comparison of CT values between Auto Baseline 
and Manual analysis modes

CT
Reproducibility
and Sensitivity

Figure 6-27 shows the CT values and calculated quantities obtained 
using the Auto Baseline and Manual analysis modes with the 
Quantifiler Human Kit. Similar data were obtained for the 
Quantifiler Y Human Male Kit.

No statistically significant differences were observed for CT values 
and calculated quantities derived using the Auto Baseline and 
Manual analysis modes with either Quantifiler kit. 

Raji DNA CT values with Quantifiler Human

23.00

26.00

29.00

32.00

0 40 80 120 160

Sample

C
T 

Auto Baseline
Manual



Chapter 6 Experiments and Results

6-64 Quantifiler Kits User’s Manual

Figure 6-27 Comparison of CT values and the corresponding 
calculated quantities – Auto Baseline and Manual analysis modes 
– Quantifiler Human Kit

6.4.5  Discussion

6.4.5.1  Precision and Accuracy

7500 System Comparison: No statistically significant differences 
were observed in CT, slope, and R2 values between replicate samples 
run on the 7500 System (SDS Software v1.2.3) using both 
Quantifiler kits.

7500-to-7000 System Comparison: Statistically significant 
differences in CT, slope, and R2 values were observed in samples run 
on the 7500 System (SDS Software v1.2.3) versus the 7000 System 
(SDS Software v1.0) using both Quantifiler kits.

However, the data obtained from both instrument types are within the 
previously established parameter ranges published in the Quantifiler® 
User's Manual, Chapter 5, Table 5-1. 

6.4.5.2  Reproducibility and Sensitivity

Sensitivity: Similar CT values and calculated DNA quantities were 
obtained at each of the standard curve concentrations, demonstrating 
similar sensitivity results between the 7000 System (SDS Software 
v1.0) and 7500 System (SDS Software v1.2.3).
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Calculated Quantities: Data obtained using the Quantifiler Human 
Kit showed no statistically significant difference when the calculated 
quantities obtained from the 7000 and 7500 systems were compared 
(p = 0.22, with 95% confidence). However, minimally significant 
differences were observed between the two instrument types for 
calculated quantities using the Quantifiler Y Human Male Kit. 

To further explore the extent of the difference between the two 
instrument types, the percent differences between the calculated 
quantities within the concentration range of 2 ng/µL to 0.5 ng/µL 
were determined. This range was selected because it represents the 
optimal input range for most STR kits. In this range, there was, at 
most, an 18% concentration difference between calculated quantities 
using the 7000 and the 7500 systems. The impact of the slight 
differences in calculated quantities should have minimal effect on 
results of STR analysis. However, laboratories should perform the 
appropriate studies to verify optimal input amounts for amplification. 

6.4.5.3  Auto Baseline Analysis Versus Manual Analysis

No statistically significant difference was observed for CT values and 
calculated quantities derived using the Auto Baseline and Manual 
analysis modes on the 7500 System (SDS Software v1.2.3). 

6.4.6  Conclusion

This validation study demonstrates that the Applied Biosystems 
7500 Real-Time PCR System with SDS Software v1.2.3 is a robust, 
reliable, and reproducible system for performing DNA quantification 
using the Quantifiler kits. 

When statistically comparing 7500 System (SDS Software v1.2.3) 
results (CT, slope, and R2 values) to results obtained using previously 
validated ABI PRISM® 7000 Sequence Detection System with SDS 
Software v1.0:

• Differences in calculated quantities are minimal (Quantifiler Y 
Human Male Kit) or insignificant (Quantifiler Human Kit) for 
unknown samples using the 7500 and 7000 systems. 

• The differences observed should have little effect on resulting 
STR amplification based on calculated DNA quantities. 

• No significant difference is observed between CT values and 
calculated quantities derived by using Auto Baseline and 
Manual analysis modes.
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Section 6.5 ABI PRISM® 7000 Sequence 
Detection System Validation (SDS 
Software v1.2.3)

Overview The Quantifiler® Human DNA Quantification Kit and Quantifiler® Y 
Human Male DNA Quantification Kit were tested (see the 
experiments listed below) using the ABI PRISM® 7000 Sequence 
Detection System with SDS Software v1.2.3, running on the 
Windows® 2000 operating system., then compared to the previously 
validated ABI PRISM® 7000 Sequence Detection System with SDS 
Software v1.0. 

The experimental data generated demonstrate that the 7000 System 
(SDS Software v1.2.3):

• Provides accurate results when used with the Quantifiler kits for 
the analysis of genomic DNA samples.

• Produced results that are similar to the results produced on the 
previously validated 7000 System (SDS Software v1.0).

Validation
Experiments

Performed

• Precision and Accuracy
• Reproducibility and Sensitivity
• Background
• Auto Baseline versus Manual analysis

6.5.1  Materials and Methods

6.5.1.1  Reagents

To minimize variables from hand-pipetting and lot-to-lot reagent 
differences, the following set-up procedures were used throughout 
the study:

• Eight serial dilutions were made with one lot of standard DNA 
provided with the Quantifiler kits (first dilution prepared with 
500 µL DNA and 1,000 µL 10mM Tris-HCl (pH 8.0) and 0.1 
mM Na2EDTA (T10E0.1 buffer)).
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• One manufactured lot of each kit was used for all validation 
studies:

6.5.1.2  Instruments

One ABI PRISM® 7000 Sequence Detection System was used for this 
study under the following conditions:

• All experiments were run initially using SDS Software v1.0.
• The 7000 system computer was upgraded to 

SDS Software v1.2.3. 
• The 7000 System (SDS Software v1.2.3) was calibrated by an 

Applied Biosystems service engineer (background calibration, 
pure dye calibration, RNase P run).

• For the following experiments, v1.0 data was reanalyzed using 
SDS Software v1.2.3:
– Precision and Accuracy
– Reproducibility and Sensitivity
– Background

• For Auto Baseline versus Manual analysis experiments, new 
data were collected using SDS Software v1.2.3, analyzed in 
Auto Baseline mode, then reanalyzed in Manual mode.

6.5.2  Experimental Setup

Precision and
Accuracy Testing

On each 96-well reaction plate, six sets of standard dilutions for each 
Quantifiler kit were set up for real-time PCR. The experimental plate 
layout is shown in Figure 6-28.

Three replicate plates were run consecutively. The CT, slope, and R2 
values were compared to determine precision and accuracy.

Kit Part Number Lot Number

Quantifiler Human Kit 4343895 0501022

Quantifiler Y Human Male Kit 4343906 0501020
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Figure 6-28 Plate Layout – Precision and accuracy testing on the 
7000 System

Reproducibility
Sensitivity, and

Background
Testing

On each 96-well reaction plate, the following were set up for 
real-time PCR:

• Standard dilution series (two replicates of each dilution point)
• Four replicate serial dilution sets of two sample DNAs (007 and 

9948B)
• Sixteen no template controls (NTCs), which served as 

background samples

Figure 6-29 shows the experimental plate layout.

7000 System
(SDS Software v1.2.3) 

7000 System
(SDS Software v1.0)

Quantifiler® 
Human DNA 

Quantification Kit

Quantifiler® Y Human 
Male DNA 

Quantification Kit
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Figure 6-29 Plate Layout – Reproducibility and sensitivity 
experiments – 7000 Systems

One plate was run with each type of Quantifiler kit.

To demonstrate reproducibility and sensitivity, the replicate DNA 
samples were quantitated and the results were compared between 
each software version.

6.5.3  Data Collection

The standard thermal cycling protocol (9600 Emulation mode) 
described in the Chapter 3, “PCR Amplification,” was used for both 
studies.

6.5.4  Data Analysis

Initial Data
Compiling and

Analysis

All runs were analyzed initially using Manual analysis mode, with the 
baseline set to 3 to 15 and the threshold set at 0.2.

Average values and standard deviations for CT, slope, and R2 were 
calculated for all replicate samples in a run.

The instrument was then upgraded to SDS Software v1.2.3, then the 
same run files were reanalyzed and exported with the same analysis 
settings. 

Standard 
curve

DNA 1 DNA 2 NTC

Quantifiler 
Human Kit

Quantifiler Y 
Human Male Kit

Standard 
curve

DNA 1 DNA 2 NTC

Standard
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For Manual-to-Auto-Baseline analysis comparisons, the run files 
from the 7000 System (SDS Software v1.2.3) were reanalyzed using 
the Auto Baseline mode and a threshold of 0.2.

6.5.4.1  Precision and Accuracy

For the precision and accuracy tests between the two software 
versions, the average CT, average slope, and average R2 values were 
determined.

CT Results Figures 6-30 to 6-32 show CT values obtained using the SDS 
Software v1.0 and v1.2.3. The data consistently show that SDS 
Software v1.2.3 yields lower CT values (2% difference).

Figure 6-30 Average CT values – Quantifiler Human Kit – SDS 
Software v1.0 and v1.2.3 (error bars indicate standard deviations)
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Figure 6-31 Average CT values – Quantifiler Y Human Male Kit – 
SDS Software v1.0 and v1.2.3 (error bars indicate standard 
deviations) 

Figure 6-32 CT Values per Sample – v1.0 compared to v1.2.3 – 
Quantifiler Human Kit
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Slope Results Figure 6-33 shows the average slope values obtained using the SDS 
software v1.2.3 compared to v1.0. The slope values obtained for the 
7000 System (SDS Software v1.2.3) are within the established 
ranges.

A 1% slope difference is observed between the v1.2.3 and v1.0 
software.

Figure 6-33 Average slope values – SDS Software v1.0 and 
v1.2.3

Kit Slope Established Slope 
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Quantifiler Human Kit −2.90 to −2.97 −2.9 to −3.3
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R2 Results Figure 6-34 shows that SDS software v1.2.3 yields data that are 
within the acceptable range of R2 values: 0.98 to 1 for both kits 
(<0.5% difference).

Figure 6-34 Average R2 values – Quantifiler Human Kit and 
Quantifiler Y Human Male Kit – SDS Software v1.0 and v1.2.3.

6.5.4.2  Reproducibility and Sensitivity 

Two sample DNAs were quantitated for this experiment. Eight 2-fold 
serial dilutions for each sample were run (four replicates per dilution, 
32 wells per sample). The CT values were generated in Manual 
analysis mode, then the quantities were calculated using the standard 
curve on each plate.

Figure 6-35 shows the CT values for 007 and 9948B across a set of 
eight serial dilutions (~30 ng/µL to 0.1 ng/µL) with the Quantifiler 
Human Kit and the corresponding quantitated concentrations. 

As the data show, differences in CT values do not affect calculated 
quantities (calculated quantities were normalized, resulting in 
comparable concentrations from results generated with both software 
versions.)
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Figure 6-35 Average CT values and quantitated DNA 
concentrations – 007 and 9948B – Quantifiler Human Kit

Figure 6-36 shows CT results for the Quantifiler Y Human Male Kit 
that differ slightly between the v1.0 analysis and the v1.2.3 analysis. 
However, differences in CT values do not affect calculated quantities 
(calculated quantities were normalized resulting in comparable 
concentrations from results generated with both software versions.)
 

Figure 6-36 Average CT values and quantitated DNA 
concentrations – 007 and 9948B – Quantifiler Y Human Male Kit
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Figure 6-37 shows that there was a ≤6% quantity difference between 
results obtained with v1.0 and v1.2.3 software.

Figure 6-37 Percent DNA quantity differences – SDS Software 
v1.0 and v1.2.3

6.5.4.3  Background

Figure 6-38 shows the background results for 16 NTCs and one 
positive control for both kits run on the 7000 System (SDS Software 
v1.0). One out of 16 NTCs for the Quantifiler Human Kit resulted in 
a <40 CT result (36.81 CT). Remaining NTCs resulted in >40 CT 
values (negative results).

Figure 6-38 Background amplification plots – 7000 System (SDS 
Software v1.0)
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Figure 6-39 shows the background results for 16 NTCs and one 
positive control for both kits reanalyzed on the 7000 System (SDS 
Software v1.2.3). One out of 16 NTCs for the Quantifiler Human Kit 
resulted in a <40 CT value (38.26 CT). Overall, the NTC results do 
not change when analyzed with version 1.2.3. 

Figure 6-39 Background amplification plots – 7000 System (SDS 
Software v1.2.3)

6.5.4.4  Auto Baseline Analysis Versus Manual Analysis

CT Precision and
Accuracy

For Manual-to-Auto-Baseline analysis comparisons:

• Data from initial runs were collected with SDS Software v 1.2.3 
and analyzed in Manual analysis mode, then reanalyzed in Auto 
Baseline analysis mode (default threshold 0.2).

• The CT values were compared to each other.

Figures 6-40 and 6-41 show the average CT values between Auto 
Baseline analysis and Manual analysis. There is a <2% difference 
between the two analysis methods for both kits. 

Quantifiler Human Kit Quantifiler Y Human Male Kit
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Figure 6-40 Comparison of CT values between Auto Baseline 
and Manual analysis – Quantifiler Human Kit (error bars indicate 
standard deviations)

Figure 6-41 Comparison of CT values between Auto Baseline 
and Manual analysis – Quantifiler Y Human Male Kit (error bars 
indicate standard deviations)
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CT
Reproducibility
and Sensitivity

Figure 6-42 shows the CT values obtained using the Auto Baseline 
and Manual analysis modes with the Quantifiler Human Kit. 

No significant differences were observed for CT values generated 
using the Auto Baseline and Manual analysis modes with either 
Quantifiler kit.   
 

Figure 6-42 Average CT values and average calculated quantities 
for 9948 and 007 – Quantifiler Human Kit (~30 ng/µL to 0.1 ng/µL)

Figure 6-43 shows the CT values obtained using the Auto Baseline 
and Manual analysis modes with the Quantifiler Human Kit.
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No significant differences were observed for CT values generated 
using the Auto Baseline and Manual analysis modes with either 
Quantifiler kit. Auto Baseline CT values overlap the manual CT 
values. The corresponding quantities also overlap.
 

Figure 6-43 Average CT values and average calculated quantities 
for 9948 and 007 – Quantifiler Y Human Male Kit

6.5.5  Discussion

6.5.5.1  Precision and Accuracy

The results from SDS Software v1.0 and v1.2.3 on a 7000 System 
slightly differ in CT value (2% difference), slope (1%), and R2 
(<0.5%) for both Quantifiler kits. All v1.0 data and v1.2.3 data are 
within the Quantifiler® User’s Manual published parameter ranges. 

6.5.5.2  Reproducibility and Sensitivity

For both Quantifiler kits, there was a maximum difference of 6% 
when the calculated quantities using v1.0 and v1.2.3 were compared. 
Such minor differences in calculated quantities should not affect the 
ability to obtain interpretable STR profiles using the optimal input 
amount determined by individual laboratories during validation of the 
Quantifiler kits. 
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6.5.5.3  Manual Analysis Versus Auto Baseline Analysis

CT values and their corresponding calculated quantities showed a 
maximum 8% difference between Auto Baseline and Manual analysis 
modes on the 7000 System (SDS Software v1.2.3). However, the 
differences observed should have little effect on resulting STR 
amplification based on calculated DNA quantities.

6.5.6  Conclusion

This validation study demonstrates that the ABI PRISM® 7000 
Real-Time PCR system with SDS Software v1.2.3 is a robust, 
reliable, and reproducible system for performing DNA quantification 
using the Quantifiler kits. 

When comparing 7000 System (SDS Software v1.2.3) results (CT, 
slope, and R2 values) to results obtained using the previously 
validated 7000 System (SDS Software v1.0):

• Small percentage differences are observed in CT, slope, and R2 
values. 

• Differences in calculated quantities are minimal for unknown 
samples using the 7000 System (SDS Software v1.2.3) and 7000 
System (SDS Software v1.0). 

• The differences observed should have little effect on resulting 
STR amplification based on calculated DNA quantities. 

• No significant difference is observed between CT values and 
calculated quantities derived using Auto Baseline and Manual 
analysis modes.
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bold text, when to use vii
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C
casework sample analysis 6-46
CAUTION, description ix
chemical safety guidelines x
chemical waste

hazards xi
safety guidelines xi

cleavage, in 5´ nuclease assay 1-5
clipped results, exporting (7900HT SDS) 4-10
comparisons with other methods

on the 7000 SDS 6-27
on the 7900HT SDS 6-42

composite spectrum 1-8
computer, starting

for the 7000 SDS 2-5
for the 7900HT SDS 2-27

contents of kit 1-16
conventions

bold text vii
for describing menu commands vii
IMPORTANTS! viii
in this guide vii
italic text vii
Notes viii
user attention words viii

CT. See threshold cycle
customer feedback, on Applied Biosystems 

documents xiv

D
DANGER, description ix
data collection 1-8
degraded DNA studies 6-23
Detector Manager 2-14
detectors (7000 SDS)

adding to plate document 2-14
analysis settings for 5-2
applying for standards 2-15
applying for unknown samples 2-17
creating 2-11

detectors (7900HT SDS)
applying for standards 2-35
applying for unknown samples 2-36
copying to plate document 2-34
creating 2-32

DNA quantification standards
dilution series, example 3-3
dilution series, guidelines for 3-2
guidelines for preparing 3-4
materials required to prepare 3-2
omitting Std. 8 5-5
preparing 3-4
reaction recommendation 3-6
See also standards

documentation, related xiv

E
equipment, not included with Quantifiler 

kits 1-17
exponential phase. See geometric phase
exporting results

on the 7000 SDS 4-6
on the 7900HT SDS 4-10

F
fluorescence, detection of 1-7

G
geometric phase, amplification plot 1-11
glycogen, adding to T10E0.1 buffer 3-2
guidelines

chemical safety x
chemical waste safety xi
waste disposal xii

H
hazards

biological xii
chemical waste xi
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I
IMPORTANT, description ix
Information Development department, 

contacting xiv
instrument, powering on

for the 7000 SDS 2-6
for the 7900HT SDS 2-27

Internal PCR Control system, See IPC system
IPC system

about assay 1-3
components 5-10
detectors for, creating on the 7000 

SDS 2-13
detectors for, creating on the 7900HT 

SDS 2-34
interpreting results of 5-10
invalid results from 5-11

italic text, when to use vii

L
linear phase, amplification plot 1-11

M
manuals. See documentation, related
materials, not included with Quantifiler 

kits 1-17
menu commands, conventions for 

describing vii
minor groove binder, description 1-4
mixture studies

on the 7000 SDS 6-21
on the 7900HT SDS 6-40

MSDSs
description x
obtaining x, xiv
referring to x, xi

multicomponent data
exporting (7900HT SDS) 4-10
printing (7900HT SDS) 4-10
processing of 1-9

N
negative results 5-11
New Document dialog box

7000 SDS 2-10
7900HT SDS 2-31

nonfluorescent quencher, description 1-4

O
Optical Adhesive Cover, sealing plate 

with 3-6

P
passive reference

multicomponent analysis, use in 1-9
normalization using 1-10
selecting in Well Inspector (7000 

SDS) 2-15, 2-17
selecting in Well Inspector (7900HT 

SDS) 2-36, 2-37
PCR

inhibition 5-11
kinetic analysis of 1-10
phases of 1-11
process in 5´ nuclease assay 1-4
reactions, preparing 3-5
reactions, running on the 7000 SDS 3-7
reactions, running on the 7900HT SDS 3-9
standard, preparing 3-2

plate document (7000 SDS)
analyzing 4-3
creating blank 2-10
creating from a template 2-24
detectors, adding 2-14
detectors, applying for standards 2-15
detectors, applying for unknown 

samples 2-17
detectors, creating 2-11
how used 2-7
sample names, adding 2-18
saving 2-21
setup examples 2-8
template, creating 2-22
template, setting up 2-22
thermal cycler conditions, setting 2-19
types 2-7
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plate document (7900HT SDS)
analyzing 4-7
creating blank 2-31
creating from a template 2-42
detectors, applying for standards 2-35
detectors, applying for unknown 

samples 2-36
detectors, copying 2-34
detectors, creating 2-32
how used 2-28
sample names, adding 2-37
saving 2-39
setup examples 2-29
template, creating 2-40
template, setting up 2-40
thermal cycler conditions, setting 2-38
types 2-28

plateau phase, amplification plot 1-11
polymerization, in 5´ nuclease assay

completion of 1-6
process 1-5

precision
on the 7000 SDS 6-4
on the 7900HT SDS 6-37

printing results
on the 7000 SDS 4-6
on the 7900HT SDS 4-10

probes, about 1-4
pure dye spectra, how used 1-9

Q
Quantifiler Human detector

creating (7000 SDS) 2-12
creating (7900HT SDS) 2-32

Quantifiler Y detector
creating (7000 SDS) 2-12
creating (7900HT SDS) 2-33

quantity
assessing 5-16
entering for detector (7000 SDS) 2-16
exporting (7000 SDS) 4-6
printing (7000 SDS) 4-6
viewing (7000 SDS) 4-5
viewing (7900HT SDS) 4-9

R
R2 value

interpreting 5-4
viewing (7000 SDS) 4-4
viewing (7900HT SDS) 4-8

radioactive waste, handling xii
raw data

about 1-8
printing (7000 SDS) 4-6
printing (7900HT SDS) 4-10

reactions
examples of arranging 2-8, 2-29

real-time data analysis 1-10
regression line formula 5-4
replicates

grouping in exported results (7900HT 
SDS) 4-10

results, how grouped 2-18, 2-37
report

exporting and printing on the 7000 
SDS 4-6

exporting and printing on the 7900HT 
SDS 4-10

viewing on the 7000 SDs 4-5
reporter signal, normalized

about 1-10
viewing in amplification plot (7000 

SDS) 4-4
viewing in amplification plot (7900HT 

SDS) 4-8
reproducibility 6-7
results

exporting (7900HT SDS) 4-10
viewing (7000 SDS) 4-4
viewing (7900HT SDS) 4-8

Rn. See reporter signal, normalized
ROX

selecting in Well Inspector (7000 
SDS) 2-15, 2-17

selecting in Well Inspector (7900HT 
SDS) 2-36, 2-37
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S
safety

biological hazards
chemical waste xi

safety alert words
CAUTIONS ix
DANGERS ix
description ix
IMPORTANTS ix
WARNINGS ix

sample name
adding for unknown samples (7000 

SDS) 2-18
adding for unknown samples (7900HT 

SDS) 2-37
entering for detector (7000 SDS) 2-16
entering for detector (7900HT SDS) 2-36

SDS document. See *.sds file
*.sds file

description (7000 SDS) 2-7
description (7900HT SDS) 2-28
saving (7000 SDS) 2-21
saving (7900HT SDS) 2-39
See also plate document (7000 SDS) and 

plate document (7900HT SDS)
SDS software

starting for 7000 SDS 2-6
starting for 7900HT SDS 2-27

SDS template. See *.sdt file
*.sdt file

description (7000 SDS) 2-7
description (7900HT SDS) 2-28
saving (7000 SDS) 2-23
See also template

sensitivity
of assay 5-16
tests 6-16

Services and Support, obtaining xiv
setup table, exporting (7900HT SDS) 4-10
single plate document. See *.sds file (7900HT 

SDS)
slope of standard curve

about 5-4
differs significantly from -3.33 5-6
interpreting 5-5

viewing (7000 SDS) 4-4
viewing (7900HT SDS) 4-8

specificity
with bacterial pools panel 6-14
with human DNA panel 6-10
with non-human panel 6-11

stability 6-17
standard curve

about results 5-4
differences in CT values of replicates 5-9
interpreting 5-4
outlier in, example of 5-8
print setup (7000 SDS) 4-6
replicates, example of four 5-9
straight horizontal line 5-7
troubleshooting 5-6
viewing (7000 SDS) 4-4
viewing (7900HT SDS) 4-8

standards
applying detectors for (7000 SDS) 2-15
applying detectors for (7900HT 

SDS) 2-35
See also DNA quantification standards

stochastic effects 5-16
storage recommendations, for kits 1-16
strand displacement, in 5´ nuclease assay 1-5

T
T10E0.1 buffer, contents of 3-2
TaqMan® MGB probe 1-4
targets, about 1-3
task

selecting for detector (7000 SDS) 2-16
selecting for detector (7900HT SDS) 2-35

Technical Support, contacting xiv
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template
creating plate document from (7000 

SDS) 2-24
creating plate document from (7900HT 

SDS) 2-42
saving (7000 SDS) 2-23
saving (7900HT SDS) 2-41
setting up for plate documents (7000 

SDS) 2-22
setting up for plate documents (7900HT 

SDS) 2-40
template plate document. See *.sdt file
text conventions vii
thermal cycler conditions

printing (7900HT SDS) 4-10
setting (7000 SDS) 2-19
setting (7900HT SDS) 2-38

threshold
settings for the 7000 SDS 4-3
settings for the 7900HT SDS 4-7

threshold cycle
calculation of 1-13
exporting (7000 SDS) 4-6
in standard curve 5-4
normal range for IPC system 5-11
printing (7000 SDS) 4-6
relationship to initial template 

amount 1-14
viewing in amplification plot (7000 

SDS) 4-4
viewing in amplification plot (7900HT 

SDS) 4-8
viewing in standard curve (7000 SDS) 4-4
viewing in standard curve (7900HT 

SDS) 4-8
training, information on xiv

U
unknown samples

detectors, applying for (7000 SDS) 2-17
detectors, applying for (7900HT 

SDS) 2-36
names, adding (7000 SDS) 2-18
names, adding (7900HT SDS) 2-37

user attention words, described viii

V
validation

7000 SDS, SDS v1.0 software 6-3
7000 SDS, SDS v1.2.3 software 6-66
7500 Real-Time PCR System, SDS v1.2.3 

software 6-51
7900HT Real-Time PCR System, SDS v2.0 

software 6-37
background, assay 6-35
comparisons with other methods 6-27
comparisons with other methods (7900HT 

SDS) 6-42
degraded DNA studies 6-23
importance of 6-2
mixture studies 6-21
mixture studies (7900HT SDS) 6-40
precision 6-4
precision (7900HT SDS) 6-37
reproducibility 6-7
sensitivity 6-16
specificity with bacterial pools panel 6-14
specificity with human DNA panel 6-10
specificity with non-human panel 6-11
stability 6-17

W
WARNING, description ix
waste disposal, guidelines xii

Y
y-intercept of standard curve

interpreting 5-4
viewing (7000 SDS) 4-4
viewing (7900HT SDS) 4-8
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